
SYSTEM 7.S~ EDITION 

I ® 

ac1ntos 
• • s 

' 

:The Visual Quick Reference 
I 





Macintosh™ 
VisiRef 

Mary Jo Fahey 

Mel Sobol 

with 

Stephanie Gould 

oue 



Macintosh VisiRef 

Copyright © 1994 by Que~ Corporation. 

All rights reserved . Printed in the United States o f Am erica. No 
part o f this boo k may be used or reproduced in any fo rm o r by any 
means, o r stored in a database o r re trieva l system, without prior 
writ ten permission o f the publisher excep t in the case o f brief quo­
tations embodied in critical a rticles and reviews. Making copies of 
any part of this book for any purpose o ther than your o wn personal 
use is a v iolation of United States copyright laws. For in fo rmation, 
address Que Corpo ratio n, 201 W. 103 rd Street, Indianapolis, IN 
46290. 

Library of Congress Catalog No.: 94-67593 

ISBN: 1-56529-83 1-4 

This book is sold ns is, without warranty o f any kind, ei ther express 
o r implied, respecting the con tents of th is book, including but no t 
limited to implied warranties for the book's quality, performance, 
merchantability, o r fitness for any particular purpose. Neither Que 
Corporation no r its dealers or distributo rs shall be liable to the pu r­
chaser o r any other person o r entity with respect to any liabili ty, 
loss, o r damage caused or a lleged to have been caused di rectly or 
ind irectly by this book. 

97 96 95 94 6 5 4 3 2 

In terpretatio n o f the printing code: the righ tmost double-digit 
number is the year o f the book's printing; the rightmost single-digit 
nu mber, the number o f the book's printing. r o r example, a print­
ing code o f 94-1 sho ws that the first printing of the book occurred 
in 1994. 

Screen reproductio ns in th is book were created usi ng Ca pture from 
Mainstay, Camarillo, CA. 

Publisher: David P. Ewing 

Associate Publisher: Corinne Walls 

Publishing Director: Urad R. Koch 

Managing Editor: Anne Owen 

Product Marketing Manager: Greg Wiegand 

II 



Credits 

Publishing Manager 
Thomas H. Bennett 

Acquisitions Editor 
Na ncy Stevenson 

Product Director 
Stephanie Gould 

Production Editor 
Chris Nelson 

Editors 
Danielle Bird 
Patrick Kanouse 
Heather Kaufman 
Susan Ross Moore 

Technical Editor 
Todd Knowlton 

Acquisitions Assistant 
Ruth Slates 

Editorial Assistant 
Theresa Mathias 

Book Designer 
Amy Peppier-Adams 

Cover Designers 
Dan Armstrong 
Amy Peppier-Adams 

Production Team 
Claudia Bell 
Cameron Booker 
Stephen Carlin 
Anne Dickerson 
Rich Evers 
Bob LaRoche 
Steph Mineart 
Mary Beth Wakefield 
Dennis Sheehan 
Michael Thomas 
Teresa Forrester 

Indexer 
Michael Hughes 

Composed in Stone Serif and MCPdigital by Que Corporation 



About the Authors 
Mary jo Fahey is a New York City software/hardware consultant 
and writer. She assists ad agencies, publishers, and graphic design 
firms to adopt technology in the areas of computer graphics, multi­
media, and crossplatform software integration . Her articles have 
appeared in HOW magazine, Personal Computing, and the American 
Marketing Association's Marketing News. 

Mel Sobol has a doctorate in physics from New York University. 
He has taught at four universities. He was on the technical staff of 
Bell Laboratories and programmed computers for the American 
Institute of Physics. At the present time, Dr. Sobol is a Mac consul­
tant and trainer specializing in the areas of desktop publishing and 
presentations. 

Trademark 
Acknowledgments 
All terms mentioned in this book that are known to be t rade­
marks or service marks have been appropriately capitalized. Que 
Corporation cannot attest to the accuracy of this information. 
Usc of a term in this book should not be regarded as affecting 
the validity of any trademark or service mark. 



Contents 
Introduction vi 

Basics: 
Power Up/Shut Down, Desktop, Icons, Menus, Windows 

Color: Bo rders, Text Highlight, Desktop, Labels, Monitors 16 

Customizing: Apple Menu, Mouse, Keyboa rd, Extensions 22 

Data Exchange: 
Clipboard , Publish and Subscribe, PC Exchange 34 

Desk Accessories: Calculator, Key Caps, Notepad, Puzzle 46 

Disks: Hard Disks, RAM Disks, Floppies, CD-ROM 57 

E-Mail: PowerTalk, Info rmation Cards, Ca ta logs 65 

File Management: Folders, Documents, Applicat ions 82 

Help: Macintosh Guide, Balloon, Shortcuts 93 

Networking: 
Connect, Register, Privi leges, Passwords, Linking 98 

Printing: 
Fonts, QuickDraw GX, Portable Digita l Documents 121 

Security: Protect Files, Di sks, System, Disk Fi rst Aid 133 

Sound: Volume, Beep, Install, Remove, Record, Audio COs 137 

Index 141 

v 



How To Use This Book 
Welcome to a revolutionary concept in quick references! Unlike t ra­
ditional pocket references, which usually pack a lot of text on the 
page but few, if any, illustrations, the VisiRefseries presents nearly 
all of its "how to" information visually. You'll fi nd all the essential 
tasks here, color-coded and organized alphabetically by larger task 
category. Use the color-coded sections to locate quickly the task 
you need to find, follow the full-color screen shots to see each step 
in the process, and then do it yourself. If you're someone who 
prefers to learn or recall information by being shown how a task is 
accomplished, Que's VisiRefseries is well-matched to your needs. 
The VisiRefbooks are the perfect complement to today's graphical 
software. You don't have to read a lot of text to find the reference 
information you need. 

Each page provides the fo llowing information: 

Color-coded pages make it easy to 
lind the task category you need. 

VI 

' · . 

Using Publish and Subscribe 
Usln~ COp) .:md Paste, ~·ou cau paste a ch:ut or logo Into an ot h\'r 
docum~:nt .1nd then intclllgcmly link that Chilrt or logo 10 theorlgl· 
na t h'ilh l'ubll~ h and Subscribe. Wlwn th t' mlginal gl!t~ chJu.;t"<l. 
thl' chang~·\ .tn• auwm.:~ticall}' u.tn~fl'm.-d to tht• copy. 

To publish an ite m 

Aumil*'edtfhreai/£J.Jn 
Wllic:nc;¥\ te efW9ed 

Headings describe 
what you want to do. 

Full-color screen shots 
show you each step in 
the process. 

Brightly colored, 
numbered steps are 
easy to lind. 



Turning the Computer On 
and Off 
Although all Macintosh models are designed to be turned off the 
same way, the technique to power on varies. Some models have a 
Power On key on the keyboard, others have an on/off switch on 
the computer. You also can shut the Mac down and immediately 
restart by using the Restart com mand from the Special menu. 
You use this command when you install a new program, add a 
new peripheral such as a hard drive or printer, or your Mac 
starts to behave erratically. 

To turn the computer on 
1 Turn on your Macintosh using the Power On key or On/Off switch. 

Power On Key E]\ 
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If necessary, use your Macintosh 
User's Gu ide for assistance. 
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To turn the computer off 

1 Open the Special menu. 

To shut the Mac down 
and immediately restart 
it, choose Restart from 

the Special menu. 

~pr<1a l 

o I · 

Eject Disk iCE 
Erase Disk ... 

I 'm at ... 
Unlock Key Chain ... 
Ulsllor·s MallboH ... 

L-----t- Restart 
\hut Down 1 

II . 
. . 
-
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Basics: Power Up/Down, Desktop, Icons, Menus, Windows 

The Desktop 
The Desktop or main work area is analogous to your own desktop, 
with windows that can be arranged like pieces of paper and a t rash 
can for throwing items away. 

Application menu 

Apple Guide menu 

Apple menu Hard disk icon 

Trash Can 

2 



Basics: Power Up/Down, Desktop, Icons, Menus, Windows 

Using Icons 
Files, folders, applications, the Trash Can, and ha rdware devices 
may be represented as icons. An icon's visual characteristics help 
you identify it. For example, the Trash Can icon looks like a gray, 
metal garbage can, and folder icons look like tabbed file fo lders. 

To select an icon 

The icon is highlighted. 
To click, press and quickly 
release the mouse button. 

To select a group of icons 

To drag-select a group of icons 

1 Click in the window. 

To drag, hold down the mouse button while moving the mouse. 

3 



Basics: Power Up/Down, Desktop, Icons, Menus, Windows 

To change the name of an icon 

1 Click the name of an icon to select it. 

2 Type a new name and press Return. 

To open an icon 

1 Double-click the icon (click the mouse button twice rapidly). 

The icon window opens showing Its contents. 



Basics: Power Up/Down, Desktop, Icons, Menus, Windows 

To move an icon to a new folder 

1 Drag the icon to a new folder. 

To copy an icon to a disk 

5 



Basics: Power Up/Down, Desktop , Icons, Menus, Windows 

To get information about an icon 

U.l!!!!!lll!ll ro ~>'2c Info 

Kfnd :s«.nd 
Stu: l~ondts:k (16 1 ,09"bl.lt~J. U:Hd) 

Crut•d :Sit ,Jtwt 4, 1994,10;39 N-1 
Hodlft•d :Sit ,.lJn 4, 1994,10:39 AM 

Yorston : n/ • 

0 Lochd 

Using Menus 

Information ab:Jut 
lhe icon 

For menus to remain open, the mouse button must be held down . 
A black menu item means the menu item is available, an ellipsis 
means a d ialog box will fo llow, and shortcut keys are listed to the 
right on some menus. 

(j5] Recent Documents 
15m Aecen l Seruers 
~Scrapbook 

<fl Stickles . . 

Auto Power On/ Off 

ColorSync'" System Profile 
Dote & Time 

Lnuncher 
Macintosh Eosy Open 
Map 
Memory 

3 Drag to the right and the submenu appears . 
• Ill 

6 

Do not release lhe 
mouse button 

until the steps are 
complete. 



Basics: Power Up/Down, Desktop~ Icons, Menus, Windows 

Using Windows 
Icons that represent programs, documents, or hardware devices 
open up into windows that have a consistent structure and are 
handled in similar ways. 

To move a window 

To close a window 

1 Select the window you want to close. 

WorksWizDrds 
61ttnU 174.71"'6 In disk 57 ..2MB •v•il.-blt 

<X <X <X 9 ~ 

C•rtlfieatt GrHt~wd r-.ws .. tt•~"" Nf'wslttt•,.-T1>s 

<X 9 
Prtstnht iotl Prtstnt•hon Tips i{j 

IC 

2 Click the Close box. 

To close all open windows hold down the Option key and click the Close box. 

The window is minimized to an icon. 

7 



Basics: Power Up/Down, Desktop, Icons, Menus, Windows 

To resize a window 

Click the Zoom box to size the window so I hat all of its contents are 
visible (if possible). Click again to return to original size. 

To bring a window to the front 

The selected window moves to lhe front. 

8 



Basics: Power Up/Down, Desktop, Icons, Menus, Windows 

To hide or show windows 

Drag to choose Hide to hide the active appl ication. 

Choose Hide Hide Microsoft works <1.0 

Others to hide--+­
application 

windows that are 
not active. 

~ Cnpture Ulewer 2.2 
fJ Finder 
~ Microsoft OLE Mnnnger 2.0 I 

../.f) Microsoft Works 4.0 
., Slm l eTeHt 

Choose Show All to display all hidden windows. 

Viewing the Contents 
of a Window 

Choose from 
among the open 
applications to 
make a different 
application active. 

Windows are rarely large enough to d isplay the to tal con tents of a 
document or a disk. As a result, you can use various techniques to 
see what cannot be displayed all a t o nce. There are also different 
ways to view the contents of a window so that different types of 
information are available. You can view the contents of a window 
as a list or as icons. Lists ca n be o rdered by name, size, kind, label, 
or date. 

To scroll the contents of a window 

To use the View menu 

1 Click to select a window. 

When By Name is selected, Iiles are listed alphabetically. 
9 



Basics: Power Up/Down, Desktop, Icons, Menus, Windows 

To view the contents of a window as an 
outline 

Scr ipt Editor 

Click the triangle icon to collapse the view. The list of contents 

To specify which information appears in 
list views 

10 

~ AppleCD Audio Player 
CJ Automated Tasks ~ 

EJ Calculator 
~Chooser 
1!/ll ( ontr ol PanPI\ 
0Find File 
~ Jigsaw Puzzle 
[d Key Cnps 

.... 
Color 
ColorSync'" System Profile 
Date ll' Time 
Desktop Patterns 
EHtenslons Monoger 
File Shoring Monitor 
6enerol Controls 
Keyboard 
labels 

CJ Mall nnd Cntnlogs 
b:J Note Pnd 

._ launcher 

~Recent Applications ~ 

[iS) Recent Documents ._ 
Ill Scrapbook 
~Stickles 

• Shut Down 

Macintosh Easy Open 
Mop 
Memory 
Monitors 

2 Choose Control Panels, Views. 
I It 

PC EHchn e 
PowerTnl Setup 
Shoring S tup 
Sound 
Startup 0 k 
TeHt 
Users & 6 oups 

Wlndo Shode 



Basics: Power Up/Down, Desktop, Icons, Menus, Windows 

To hide or show windows 

Drag to choose Hide to hide the active application. 

Choose Hide 
Others to hide--+­

application 
windows that are 

not active. 

Choose Show All to display al l hidden windows. 

Viewing the Contents 
of a Window 

Choose from 
among the open 
applications to 
make a different 
application active. 

Windows are rarely large enough to display the total con tents of a 
docu ment o r a disk. As a result, you can use various techniques to 
see what cannot be displayed all at once. There are also different 
ways to view the contents of a window so that di fferent types of 
information are available. You can view the conten ts of a window 
as a Jist o r as icons. Lists ca n be o rdered by name, size, kind, label, 
or date. 

To scroll the contents of a window 

To scroll more 
quickly, drag 
the scroll box - 1------------+ 
or click in the 

scroll bar. 

To use the View menu 

1 Click to select a window. 

When By Name is selected, files are listed alphabetically. 
g 



Basics: Power Up/Down, 

To view the contents of a window as an 
outline 

Script tditOf" 

icon to collapse the view. The list of 

To specify which information appears in 
list views 
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~ AppleCD Audio Player 
CJ Automated Tasks • 
~ Calculator 
~Chooser 
!'!!Control PdnL•I' 
~ find File 
~ Jigsaw Puzzle 
Gil Key Caps 
CJ Moll ond Cotnlogs • 
b:) Note Pad 
Ill Recent Applications • 
(h) Recent Documents • 
~Scrapbook 

~Stickles 
• Shut Down 

Col or 
ColorSync'" System Profile 
Dote ll' Time 
Desktop Patterns 
EHtenslons Manager 
file Shoring Monitor 
General Controls 
Keyboard 
Labels 
launcher 
Macintosh Easy Open 
Map 
Memory 
Monitors 

2 Choose Control Panels, Views. 
' ,. 



Basics: Power Up/Down, Desktop, Icons, Menus, Windows 

3 Select View options. 

Cl ick 
Straight Grid 
or Staggered 

Grid. 

0 C~\cubtt fo16tr sites 
0 Show d1sk 1Mo in ht~dtf" 

Click to open the Font pop-up 
menu and a font. 

Click to open the 
Size pop-up 

1--+-- menu and choose 

[8]Shovstu 
[8Jshov k\rld 

[8] Shov l1tal 

[8] Show d.lltt 

0 St.ov vtrs\on 
0 Shov eo<r<ntnts _ __J, 

a font size. 

Click the types 
of information 
you want to see 
in list views. 

Click Always Snap to Grid if you want 
icons to be attracted to an invisible grid. 

Cleaning Up Windows 
Window clean up refers to arranging icons when you're in View by 
Icon mode. 

Icons snap to an invisible grid. 

LJ LJ 
MKrosoft 'w'Of"k:s 4 .0 C-~~pturu 

• 
11 



Basics: Power Up/Down, Desktop, Icons, Menus, Windows 

To c lean up a group of select ed icons 

1 Shift-click or drag-select a group of icons. 

IIIIE 

I 'm at. .• 
Unl ock Keu Chain ... 

Restart 
Shut Down 

2 Hold down the Shift key and choose Special, Clean Up Selection. 

To clean up and sort 

12 

2 Choose View, By Name. 

3 Choose View, By Icon. 

4 Hold down the Option key and choose Special, Clean Up by Name. 

D 
Applic.ttioru: 

IIIIE 

I 'm at ... 
Unlock Key Chain ... 

Restart 
Shut Down 

I a 
D 
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Basics: Power Up/Down, Desktop, Icons, Menus, Windows 

Icons sorted by name 

Macintosh HD ·~ 8 UtmS 18~ . 1 MStndis\c 46.8 M9 ~v•n.blt 

LJ LJ LJ LJ 
;:!,! 

Applt Extru AppUc• Uons CIPtUI"U F1lt s July 199 .. 

LJ (J[] LJ 
M~ro soft "W'orks4.0 svsttmf'oldtr Utilttlts 

CJ 
'W'ork Sp.te;t 0 

C> l I~ 1!1 

The list view selected in 
step 2 is the order the icons 

will be sorted in step 4. 

Capturing and Printing the 
Contents of a Window 
Capturing and printing the contents of a window applies to win­
dows that display the contents of a disk. Use the Print command in 
your application program to print your documents. 

To take a snapshot of the screen, and view 
and print it 

1 Press J:e+Shift+3 to take a snapshot of the screen. 

The captured screen shot displays. 

more ..,. 

13 



Basics: Power Up/Down, Desktop, Icons, Menus, Windows 

• 0 

Poges: ® Rll 

0 From: I I To: Ll ---' 

e 
Pr'int Tim. 

Copies: ~ I:8J Collate Copies 

Pnper Fe : ® Rutomotlc 
Q Monuol 

~ Desllnotl : I Printer •I Quollty: I Best •I 

s Specify the number of copies. 

See the Print dialog 
box in the preceding 

section. 

If the printout is too large or gets cut off, open the Page Setup menu and try 
selecting landscape orientation or scaling the image to 70% or 80%. 

Using WindowShade 
WindowShade allows you to manage your screen space by minimiz­
ing a window to its most essential identifiable element- the t itle bar. 

To shrink or expand a window 

28k MS 'W'orks 3 doc..vn. .. -

Lotus 1-2-3 24K MS 'w'orks 3 docum ... -

M~'irih·5.0 20K MS Yorks 3 doQ.m. .. -

14 



Basics: Power Up/Down, Desktop, Icons, Menus, Windows 

The window shrinks to the ti tle bar. 

You can change the keystroke combination used in the 
WindowShade control panel. (See the following section.) 

ick the title bar to 
expand the window again. 

To change keystrokes for WindowShade 

.... 
Color 
ColorSync~ System Profile 
Date &Time 
Desktop Patterns 
EHtenslons Manager 
File Sharing Monitor 
General Controls 
Keyboard 
labels 

• Launcher 
Macintosh Easy Open 

• Map 
Memory 
Monitors 
Mouse 
Network 
Numbers 
PC EHchange 
Power1'alk Setup 
Sharing Setup 
sound 
Startup Disk 
TeHt 
Users & Groups 
Ulews 

3 Click Off, 2, or 3. 

s Click to turn sound on or off. 

15 



Color: Borders, Text Highlight, Labels, Monitors 

Using Color in Window 
Borders, Text Highlight, 
and the Desktop 
Changing colo r in window borders, text high light, and the Desktop 
offers you control over the appearance of the Finder. 

To change the color of a window and/or 
text highlight 

File Edit Ulew Label Special 
About This Macintosh ... 

I!§ AppleCD Audio Plsyer 
CJ Rutomst ed Tasks ~ 

E) Calculstor 
~Chooser 

1!!.5 Control Pon~l\ 

~Find File 
~ Jlgsow Puzzl e 
~Key Csps 

Apple M enu Options 
ATM'" GH 
Ruto Power On/ Off 
Capture 
~olor 

~olorSync'" System Profile 
Dote & Time 
Desktop Patterns 
DDS Mounter Plus'" 
EHtenslons Manoger 

CJ Mall end Catalogs ~ File Sharln~ Monitor 

2 Choose Control Panels, Color. 

3 Open the Highlight Color pop-up menu. 

16 

1--------JI~Highllght color: 
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,.-------111'- Window color: 



Color: Borders, Text Highlight, Labels, Monitors 

To change the color of the Desktop 

2 Choose Control Panels, Desktop Patterns. 

3 Click an arrow to select a pattern. 

17 



Color: Borders, Text Highlight, Labels, Monitors 

Using Labels and Colors in 
the Label Menu 
Color and user-definable labels can be used as organizing princi­
ples. By assigning colo r and labels to icons, files are easy to find in 
the fo lder windows. 

To assign a color and a label to an icon, 
file, or folder 

Window with fi les listed in label order, 
beginning with Essential. 

To change a label or color in the Label menu 

18 

eg AppleCD Audio Player 
CJ Automoted Tosks ~ 

!ill Calculator 
~Chooser 
!ll r ontr ol Panel\ 
~ Find File 
~Jigsaw Puzzl e 
GlJ Key Caps 
CJ Moll ond Catal ogs 
(;J Note Pad 
~ Recent Appllcotlons 
(Q] Recent Documents 
!ii!lJ Aecen t Seruers 

ATM'" GH 
Auto Power On/ Off 
Coptur e 
Color 
ColorSync'" System Profile 
Dote & Time 
Desktop Patterns 
DOS Mounter Plus'"' 
EHtenslons Monager 
Fi le Shoring Monitor 
General Control s 



Color: Borders, Text Highlight, Labels, Monitors 

3 Drag to select the text you want to change. 

5 Click the color you want to change. 

6 Click anywhere on the colorwheel. 

Orlglnol: 

New: 

Hue Angle:~· !;) 
Soturatlon: ~1.1;) 

lightness:! 47.2011.1;) 

( Concel 

7 Adjust the brightness of the color with the slider. 

8 Choose OK. 

Creating a New Icon 
Customizing your Macintosh icons may be accom plished with a 
paint program such as SuperPai n t o r Photoshop. For defini tion, put 
a b lack o utline aro~tnd the image. 

1 Select your image in the paint program. 

more..,. 
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Color: Borders, Text Highlight, Labels, Monitors 

4 Click to select the icon to change. 

Macintosh HO 

CJ ..... 

Use custom icons on folders as reminders of what is inside. 

20 



Color: Borders, Text Highlight, Labels, Monitors 

Adjusting Color or Gray in 
Your Monitor 
The number of colors your Macintosh monitor can display depends 
on your hardware. 8-bit color gives you 256 colors or shades of 
gray, and 24-bit color gives you 16 million colors. 

Capture 
Colur 
ColorSync'" System Profile 
Date & Time 
Desktop Patterns 
DDS Mounter Plus­
EHtenslons Manager 
file Sharing Monitor 
General Controls 
KeybOftrd 
labels 

Network 
Numbers 
PC EHthange 
fowenalk setup 
snarmg Setu~ 
sound 

2 Choose Control Panels, Monitors. 

4 Click to select the number of colors. 

21 



Customizing: Apple Menu, Mouse, Keyboard, Extensions 

Changing the Items in the 
Apple Menu 
The Apple menu, known for its easy-to-get-at items, has evolved 
into a menu with a submenu-making even more items accessible, 
al l in one place. 

To add an item to the Apple menu 

The item 
immediately --lijiili·~·ij· ijiiii .. 

appearS in the e;j RppleCD Rudlo Player 
CJ Automated Tasks 

Apple menu. El Calculator 

~Chooser 
Ga Control Panels 
• Find File 
~ Jigsaw Puzzle 
(21 Key Caps 
CJ Mall and Catalogs 
bJ Not e Pad 
(2) Recent Applications 
~Recent Documents 
lim Recent Seruers 
(l!J Scrapbook 
~Stickles 

• Shut Down 

To remove an item from the Apple menu 

Drag the icon to another folder or onto the Desktop. 
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Customizing: Apple Menu, Mouse, Keyboard, Extensions 

To adjust submenus in the Apple menu 

3 Click to turn submenus on or off. 

5 Customize the Apple menu by indicating how many items to remember. 

Controlling Your Mouse 
Mouse trncki11g is the relationship between the distance you move 
the mouse on the mousepad and the distance the cursor or poin ter 
moves o n-screen. Double-click speed is what helps the Macintosh 
distingu ish between a double-click and two single-clicks. 

Ruto Power On/ Off 
Copture 
Color 
C,olorSync'" System Profile 
Dote & Time 
Desktop Patterns 
DOS Mounter Plus'" 
EHtensions Monoger 
File Shoring Monitor 
General Control s 
Keyboord 
Labels 
L11uncher 
Macintosh Eosy Open 
Map 
Memory 

.__,.._...;;.:.;.;;..;_;;c.;;..;;o.:.:._ __ _, Monitors 
MUU\ l' 

more..,. 
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Customizing: Apple Menu, Mouse, Keyboard, Extensions 

Slower speeds result 
in shorter on-screen 

distances. 

Faster speeds result 
---1f-- in longer on-screen 

000®00 distances. 
Slow r ast 

From left to right, slow. 
intermediate, and fast 
double-click speeds. 

Controlling Your Keyboard 
Key repeat rate refers to the rate at which characters repeat when 
you hold down a key. Delay until repeat refers to the time interval a 
key is held down before it repeats. Alternative keyboard layouts can 
easily be selected through a Control Panel setting. 

1 Open the Apple menu . 
2 Choose Control Panels, Keyboard. 

. ,, 

I§) RppleCD Audio Ployer 
D Automated Tosks ~ 

!ill tolculotor 
~Chooser 

!I'll Control Panels 

Speclol 

Apple Menu Options 
ATM'" GH 
Auto Power On/ Off 
Copture 
Color 
Colorsync'" System Pro lie 
Oote D' Time 

~ find File Desktop Potterns 
~ Jigs ow Puzzle DOS Mounter Plus'" 
WJ Key Cops EHtenslons Monoger 
D Moll ond Cotologs file Shoring Monitor 

fJ Note Pod ~G~en~e~roli.tiZJCoilniltrlliolllils···· 
~ Recent Rppl icotlons ~jill Lobe. 
(iS] Recent Documents ~ Louncher 
fig) Recent Servers Moclntosh Eosy Dpen 
Ill Scrapbook Map 
~Stickles Memory 

• Shut Down Monitors 

Change your keyboard 
layout by selecting a 

new layout from this list 

24 



Customizing: Apple Menu, Mouse, Keyboard, Extensions 

Setting the Date and Time 
Through the use o f a small battery similar to a watch battery, the 
Macintosh can keep track of the time and date. Setting the date and 
time and controll ing how these are displayed is accomplished 
through the new Date & Time control panel. 

To set the date 

2 Choose Control Panels, Date & Time. 

&me Edit Uiew lnbel Speclol( 
About This Macintosh ... 

Apple Menu Options 
ell AppleCD Audio Player ATM'" GH 
D Automated Tasks ~ Auto Power On/ Off 

B Cnlculntor Capture 

~ Chooser Color 
ColorSync'" System Profile 

' 
~ Find File Oes~top Patterns 
~ Jlgsnw Puzzl e DOS Mounter Plus'" 
GiJ Key Cops EHtenslons Mnnnger 

Close the-~~~~~~~~§!~~~~­
dialog box to 

accept the 
new settings. 

5 Click Date Formats. 

long d•t• 

PrefiH:c=J 

Weekday ... I c=J 
Month ... I c=J 
DBH ... I c=J 
Yenr ... I c=J 

0 l ending zero for dny 

TtM'sd~ , J aMUrt.,t 2 , 1992 

Thu,J¥1 2 , 1992 

112 / 92 

( Time Formots ... 

~ Menubnr Clock 

® on Q Off 

( Clock Options ... 

Shcrtd.lt• 

I Month/Dn~/Yenr ... I 
Separator: [2] 
0 l eading zero for day 

0 lending zero for month 

0 Show century 

Short 
format 
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Customizing: Apple Menu, Mouse, Keyboard, Extensions 

To set t he time and control the menu 
display 

2 Choose Control Panels, Date & Time. 

liiiill File Edit Ulcw Lobel Specloi l 
About This Macintosh ... l 

Apple Menu Options 
~ AppleCO Audio Player ATM'" GH 
Cl Automoted Tosks ~ Auto Power On/ Off 

eJ Calculator Capture 
Color ~Chooser 
ColorSync'" System Profile , ... ' ' I 

~Find File Oesi! top Patterns 
~ Jigsaw Puzzle DOS Mounter Plus'" 
(d Key Cops EH i enslons Monoger 

3 Click a number in the Current Time box. 
' 

• Dote &Time 

l!fiJ Current dote Q) Current time 

1 6/24/ 94 I ~ I 5:14:22 PM ~ ~· f--
... Time Formots ... ) 

6 Time Zone ~ Menubor Clock 
Tht t lmt t oot 1\u not bHn ® on 0 0ff S!>f'Cifif.d. 

0 Daylight Soulngs Time 

[ Set Time Zone ... ) [ Clock Options ... ) 

4 Click the arrows to move forward or back. 

s Click Time Formats. 

6 Click the pop-up menu to customize the format by country. 

7 Select the type of clock. 

0 24 hour 

® 12 hour 
Noon ll' midnight : 

0 0:00 

® 12:00 

Before noon: ~ 

Arter noon: ~ 

Seporotor: D 
0 Use l eodlng zero ror hour 
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Customizing: Apple Menu, Mouse, Keyboard , Extensions 

10 Click to set Daylight Savings Time On or Off. 

~ Current date 

1 6/ 24/ 94 I(\ 
( Date formats ... I 

6 Time Zone 

~ Hrnt tont hu M ' t~Hn 
s~lflotd. 

12 Click to highlight and select a city. 

~ current date 

1 6/ 24/ 94 

( Date Formats ... I 

6 Time Zone 

Tht tYM :cww hu not ~ 
rptoelntd . 

Q) Current time 

I 5:14:22 PM I(\ 
( Time formats ... I 

~ Menubar Clock 

@On 0 Dff 

( Clock Options ... 

Q) Current time 

I 5 :1 4:22 PM I(\ 
( Time Formats ... I 

~ Menu bar Clock 

Off 

15 Click Clock Options. 

more.,. 
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Customizing: Apple Menu, Mouse, Keyboard, Extensions 

16 Select the Menubar display format. 
17 Select a chime. 

18 Select a font. 
~ Clock Options 

Append AM/ PM to the lime 

0 Show t he dny or t he w eek 

0 Flnsh the time sepuntors 

0 Show t he bot t ery l euel 

0 Use custom clock col or: 

r-( 
7Se...,.le- t-,-I -::-C-ol-o r-,) 

Sample 

0 Chime on the hour 
0 S¥'1\fo~Of t'f"'''oH U O.If'THlthOw'" 
0 unltu: .- tc.rHn nvf'<" tt r\11"11'1~ 

Managing System 
Extensions 
Macintosh extensions are System util ities that extend System 7.S's 
capabilities and execute during startup or restarts. Sometimes 
known as "!nits," Sys tem extensions are known to con fl ict at times, 
which may cause problems at startup. Turn off problem extensions, 
o r turn off extensions when you need to free RAM memory. 

To turn extensions on or off 

28 

2 Choose Control Panels, Extensions Manager. 

ell AppleCD Audio Plnyer 

Special 

Apple Menu Options 
ATM~ GH 

CJ Automnted Tnsks ~ Auto Power On/ Off 
Capture EJ Calculator 

~Chooser 

~ Find File 
C!j Jlgsnw Puzzle 
(3 Key Caps 
CJ Mall end Catalogs 
bJ Note Pad 
@I Recent Applications 

~Recent Documents 
{$;) Recent Seruers 
Ill Strnpbook 
($1 Stickles 

• Shut Down 

Col or 
Col orSynt'" System Pro !II 
Oate & Time 
Desktop Potter-ns 
DOS Mounter Plus•" 

~ File Shnrl ng Mon. or 
General Controls 
Keyboard 
Labels 
lnuncher 
Mnt lntosh hsy Open 
Mnp 
M emory 
Monitor s 
Mouse 
Network 
Numbers 
PC [HChange 
PowerTnlk Setup 
Sharing setup 
Sound 

• 



Customizing: Apple Menu, Mouse, Keyboard , Extensions 

Undo 

Help 

Items with check marks 
..,. .. ,s.r .. ,,~---++-+-- are loaded when the 

To turn an item 
on or off. click its -+~-"'·­
name in the list. 

Undo 

Hel p 

Mac starts up. 

Choose All On to turn all extensions on. 

It 
7.5 Only 

5 Click the Close box. Choose All Off to turn all extensions off. 

Choose System 7.5 Only when you need to free RAM memory. 

6 Open the Special menu and choose Restart . 

I .. File £dll Ulew Lobel lllllm1llll 
Cleon Up Desk lop 
Em pl y Trosh ... 

[ Je<l Disk <liE 
Er ase DISk ... 

I'm nt. .. 
Unlock Key Chnln ... 
Ulsltor's Mnllbou ... 

.. 
Shut Down 

You must restart your Mac for extension changes to take effect. 
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Customizing: Apple Menu, Mouse, Keyboard, Extensions 

To save a set of extensions 

1 Select a group of extensions. 

3 Choose Save Set. 

4 Type in a na:me. 

~ Soue the c rrent sel ection 
~ under the orne: 

IPowertotk without G~l 

O[JI~II---

To delete a set of extensions 

1 Open Sets. 

2 

EHlen Ions M ono All On . 
All orr ....,._ 

./ ( U\ lOm -v3.0..2 System 7.5 Only 
[xt~a stoncs 

Ust· this control p.~ntl to b.rn __, EMExo ... 
MJ"s Slim System off probltnwtic u ttonSlOM lO ./ EvHIBf.tt 

5 Click OK. 

Choose D elete Set. 

'!IOU ~m bt .Milt tet boot voe.r __, Pr09<'"' Powerlalk without GH 
Mtcr.tosh cotT.-ct~ - ./ Applta>--

~ =~~ Soue Set.. . 
./ Aclc>ltScr I· 
./ AppltShw 
./ ~ltT_.'Ic ~Vritw 
./ ~blogsExttftS'ion 
.J C}WinQ Exttnsion 
./ Color Pidc.,.-
./ ColorSI,Inc .. 
../ fflt SMrh;l U:t.ns-kin 

I Undo ) ./ Ffle SI,!StMI £x t.nsions 
./ Find f llt ExttnSion 

I Help ) ~ ~:;:,.s;~:~~t.nsion • Ch¥'l9f'S t .. b •fff<lt .. t n stwt 
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Customizing: Apple Menu, Mouse, Keyboard , Extensions 

3 Select a set to delete. 

4 Click Delete . 

Del ete [Htenslon Set : 

MJ's Slim System 
PowerTatk w ithout GH 

({El 
0 I Cancel ) L__ _____ ....!>a 

Installing and Removing 
Control Panel Documents 
Apple has simplified the insta llation of items that belong in folders 
nested inside the System Folder. W hen you drag an item to a closed 
System Fo lder, the System identifies the item and in stalls it in its 
proper location. Unlike this "automatic" instal l, removal requires 
that folders be opened. 

To install a control panel 

1 locate the System Folder and the control panel icon to Install. 

2 Drag the control panel icon to the closed System Folder icon. 

Control panels need to be stored In the 
Control Panels folder or they may no t 
work properly. Put "ATM~ GH" Into the 
Control Panels folder? 

3 Click OK. 
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Customizing: Apple Menu, Mouse, Keyboard, Extensions 

To remove a cont rol panel 

1 Open the System Folder. 

2 Open the Control Panels folder and locate the icon to remove. 

Using Sticky Notes 
The popularity of mult icolo red sticky notes has given rise to an 
electron ic version built into System 7.5. 

To create a Sticky note 

1 Open the Apple menu and choose Stickies. 

lliiiillrlle Edit ttlew Lobel Speciolj 
About This Mocintosh ... 

@!! AppleCD Audio Ployer 
CJ Au tomoted Tosks ~ 

~ Colculotor 
~Chooser 

Q;jJ Cont rol Penels ~ 
~ Find File 
~ Jlgsow Puzzle 
f.ijJ Key Cops 
CJ M ollond Cotologs ~ 
(;:J Note Pod 
(2) Recent Appllcotlons ~ 

~ Recent Documents ~ 

1ii!!J Recent Seruers 
Ill Scropbook ..._ 
I • Shut Oollon 
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Customizing: Apple Menu, Mouse, Keyboard, Extensions 

To read or modify a Sticky note 

1 Click to select a Sticky note. 

2 Press PageUp or PageD own to see more text. 

r-----~~- Move a Sticky note by 
1 Mldtr 6t"ttd on P9· 12. 

1...-----i~~·;::;: :;.~·~~: ••· dragging its title bar. 
4 tlbwt •s mond to P9. 16. 
5 . rultseh¥1qt<! to .~pt. 

Resize by dragging on the resize box. 
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Data Exchange: Clipboard, Publish & Subscribe, PC Exchange 

Using Cut, Copy, and Paste 
Cut, Copy, and Paste make up the oldest and most basic forms of 
data exchange avai lable on the Macintosh. Elem ents are passed to 
an area in RAM memory called the Clipboard in a Cut o r a Copy 
operation and can be pasted any number of times. 

To copy and paste text or graphics from 
one document to another document 

1 Select the text or the graphic. 

10:04 PM {?J 

5 Open the Edit menu and choose Paste. 

"" .... SolllnorOeflniUons 
l'«wYoric ~!ILl~ t:iiZ ,, ~ lad~·· -
torecastlolt - Copied text 

0 
ooe $ 1 "1 ¢ 



Data Exchange: Clipboard, Publish & Subscribe, PC Exchange 

To cut and paste text or a graphic from one 
document t o another document 

1 Select the text or the graphic. 

• file Edit Format font Size Styl e Outline Ulew 9:50 PM l'll_ _IJ!I 
Mer kel nq Plan (Draft) (WP) • Tron• f er to Spreadshee t (WPl 

I 2 3 • 
z ' {) I 2 3 

T~i i'All r;iiJJ J;i;JJ I!IEOJD -~~[3 @!@ Fi!rz:JJ IAIJIA!f 1•1=1 I " I -~ .dven:isina; ~nd PR s 
mark.etina:plan . 

uld be de.,.5oped and then cclle:sc:.d. into af 

R.ea:earch Pllm c:~ ;:I:n~r;,~~~At~~~::~tim~~c= RAsearch and the · 
xnuket share, K.ensi: ~-" R.eJ.earch lioid.s lO~. Rl.ch Talent Arcn 
Raraarch Film Corpo tion h olds 4fO"' --
E.z:istm& Market Sha; W..-s .. :rc.h PWn Corporanon and Compe:titors 

~-J .......... 
~,re--.. .. c 0.& 

~"AP., . 01 ... 

~"·' 
(} 

1 ¢ ~~II Pql I 

Peste XU 
Clear 
Sel ect Rll ICR 

3 locate the document where you want to paste the item. 

-'" File Edit Format Font Size Style Outline Ulew 9:50PM 1?1 !Ill • 
Marketing Plan lOr art) (WP) Transfer to Spreadsheet (WP) 

I 2 3 • 0 I 2 3 

z 
r:::o;!J~J:iill~J I!IEOJD --~~ ... ::1_[!!) !AiJfA:Ij,-..;Jjf'!\IJ 1!13: I II J .I:! 

~ven:isin.&: and PR. should be developed and then coal.s 
ar:ketin,eplan . 

~:urch Film Corcn.tion 's lat~n comxetiton include 
surch and the 'ch TalentA,.ncy. t th~rwsen~tiJ 

~uht shu., Kensinpn Rasurch lioSds JO , Rich Ta 
~search Film Corporation hoids 4fOotl. ) I 
~z:istin&: Ma.rket Shar.JResearch PUm Corpomtion and C 

Text has been cut from document. 

100 .1:111Pq1 .. 100 .!WI Pql I QI 

4 Click to select a position in the document. 
more .,.. 
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Data Exchange: Clipboard, Publish & Subscribe, PC Exchange 

oi rue Edit Formot Font Size Style Outline Ul ew 9:51PM f'1l ill!! 
Marke ling Pl an 10ranl (WPI li1 Transfer to Spreadsheet (WP) 

I 2 3 4 I 2 3 

~ 
.t 

-~~ ~!!! 
!._ 

-~ 161"'1&"" I!EDJi:J fA' I"' I&"" I!EITD 
.dl"'ll1ising and PR s:houlcl be de .. loped. and then coalu 
nwhtinu lm. 
Rasurch Film Coii:tation's la:rrst competitors indode 
Ra:surch :and the "ch T al.ntA£ftncy. At. the preun~ 
tna:r:1at sl-..arw, Karu:mpn Re:su:rch ho"b )09tJ, Rich T 
R.tita:ch Film Corpomt10n holdJ 1oqc, Compaz . Cumtnt Matker sh... 
e:rist:in-' Md..e t Sh..G..JR.uurch Film Corporation a:td C AllStar rporatlOn ... 

JC.nsinpn R.uurch ... 
Rich TalentApncy ... 
IRAtsea:cJi Pilm CorporatiOn O.j 

I 

100 ~1:1 P ... l I 100 ~I:II P ... I •* 
The cut text is pasted into the new document. 

Using the Scrapbook 
The Scrapbook, which exists as a fi le on your hard disk, is a stable 
place to store text, graphics, sound, and QuickTime movies. 

To add an item to the Scrapbook 
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Data Exchange: Clipboard, Publish & Subscribe, PC Exchange 

·= 

A graphic 
added to the 
Scrapbook. 

eg AppleCO Audio Plnyer 
D Automated Tasks ~ 

fiil Cal culator 
~Chooser 
(;;;]Control Panels 
~ find file 
~Jigsaw Puzzle 
Iii) Key Cops 
D Mnll nnd Catalogs 
rJ Note Pnd 
@]Recent Applications 
ail Recent Documents 

Scrapbook window 

224 b\j 43 pixtls 

J Scrapbook 

Dhnenstons : 239 b\1 28~ plxtls 

Iii 

Click to see 
olher ilems in 
the Scrapbook. 
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Data Exchange: Clipboard, Publish & Subscribe, PC Exchange 

To copy a Scrapbook item into a document 

1 Cl ick to select a position in the document. 

~ 

Iii - Life nt Sen/19th Century Iii 
{t!t-.tYork I~ IILJ~ WZI!lll !¥"~ ~ [<~~J [ •:IDI!] i> 
JNormll I~ a: :IEL~• - >"_h_:.. ~ t t · IY ft.trf [lillll. 

~o. almost every twenty-four hours, wMn the watches-of the-night 
"were set,.and the-band-on de<:k sentinelled the slumbers of the band- ~ 
below; and when if-a rope was to be-hauled-upon.the forecastle, the. 
sailors.flung .!t-not rudely.down,.as by.day, but With some 

I ~ cautiou;n~ss dropt it to it;.pta.ce,. for foar of di;turbing thoir 
slumbering.shipmates;-when this sort.of steady-quietude would· 
begin to prevail, habitually the silent steersman-would watch the 
cabin - scutue; and ere long the-old man would-emerge, griping at 
the-iron-banister, to help his-crippled way.'!: 
G! 

-from Moby.Dick by-Herman MelvilleG! ~ 
nge Norma 1¢ 1 "1 . ~ ·t¢ 

liiir.FIIe Edit 
About This Mnclntosh ... 

(§} AppleCD Audio Plnyer 
D Automnt ed Tasks • 
I§ Colculntor 
~Chooser 
Q;J Control Pnne ls ... ,, 

2 Open the Apple menu and choose Scrapbook. ,.. . .. 
D Mnll nnd Cntnlogs 
r;;] Note Pnd 
@)Recent Appllcntions 
(]rJ Recent Documents 
~ Recent Seruers 

~Stickles ot 

il • Shut Down 

4 Open the Edit menu and choose Copy. 
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1 ..0 File ll!llll Ulew Insert Format Font Tools Window I 
Can't Undo 3112 
Repeat 3€Y 

cut !€H 
Cop~ !€( 

Past e Speclol.!t 
Cl ear 
Select All 8iA 

6 Open the Edit menu and choose Paste. 

Scrapbook graphic 

_ ,.so,.almost.every.twenty·four.hours,-Wilen.tlle. 
watches night were set.-and tlle·band.on de<:k sentinelled tile 
slumbers of.tlle band.below;.and.Wilen.if a rope was to be-hauled 
upon tile fore<:astie, tile sailors flung it-not-rudely down, as by day, 
but witll some cautiousness dropt It to Its place, for fear of disturbing 
tllelr slumbering shipmates; Wilen tllis.sort of.steady quietude would 
begin to prevail, llabitually tlle.s!lent steersman would watch tile. 
cabin · scuttle;.and.ere.long tlle.old man would emerge, griping at 
tile iron banister, to help his crippled way !1 
q 

Dick by Herman Melville'i 

To check the contents of the Clipboard 

Lobel Special 
!€2 

Cu t 8iH 
Copy SllC 
Past e !€U 
Clear 
Select All X A 
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Data Exchange: Clipboard, Publish & Subscribe , PC Exchange 

Using Publish and Subscribe 
Using Copy and Paste, you can paste a chart or logo into another 
document and then intelligently link that chart or logo to the origi­
nal with Publish and Subscribe. When the original gets changed, 
the changes are automatica lly transferred to the copy. 

To publish an item 

2 Open the Edit menu and choose Create Publisher. 

40 

Preutew 

A name is offered for the new edition 
which can be changed. 

3 Click Publish. 



Data Exchange: Clipboard, Publish & Subscribe, PC Exchange 

To subscribe to an edition 

The budget data for the current 
month is shown b&low: 

4 Select the edition (published item). 

Preview 

....... Deskt op 

Cnncel 
a...,...,. 

o G#J SubscrlbeLw-l~th:-:-;:1 B~e:s:;:t :;:fo:r:m:n:;:t ====:...l~•l 

The published item appears in 
the Subscriber document. 

Monthly lludg&t R&port 

The budget data for the current 
month ls shown b&low: 

• Elec:trtcltv 

O t>o> 

• Taxe.s 

• water 

8 tabla TV 

0 Mo rtoe90 
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Data Exchange: Clipboard, Publish & Subscribe, PC Exchange 

To make changes to the published and 
subscriber documents 

13~ 6~ 6~ 

%1 
•

7% 

62% 

• El eclrfclt~ 

• Taxe> 

• weter 

0 C.bleTV 

0 Hort-

The percentages have changed. 1 Make a change to the published data. 

r oi !liD Edit Gollery Chort Formot Mocro Window~ 
New... 3flN 
Open... 3fl0 
Close 3flW 
Links ... 

·S~b"!ij,eiRjsi .. i. iiii-~J,j,jij ,l!ijjijiju!ijt!l(! tl•ijt!,j,Hfi"ii 

42 

Soue Workbook... 
Delet e ... 

The subscriber document is upoated. 

De.. 

•Taxe> 

•water 

0 C.ble TY 

D Mort-



Data Exchange: Clipboard, Publish & Subscribe, PC Exchange 

Using Easy Open or PC 
Exchange to Open Files 
Macintosh Easy Open enables you to open Macintosh documents 
even if you don't have the original software program, and PC 
Exchange can read DOS-formatted disks. Assigning programs to 
each type of DOS file you anticipate using allows you to open PC 
documents in the Finder with a double-cl ick rather than open them 
from inside an application. 

To use Macintosh Easy Open 

1 Double-click the file you want to open. 

To assign a program for DOS documents 
using PC Exchange 

2 Choose Control Panels, PC Exchange. 

Capture 
Color 
ColorSync'" System Profile 
Date & Time 
Desktop Patterns 
DOS Mounter Plus'" 
EHtenslons Manager 
File Sharing Monitor 
General Controls 
Keyboard 
Labels 
Launcher 
Macintosh Easy Open 
Map 
Memory 
Monitors 
Mouse 
Network 
Numbers 

PowerTalk 
Sharing Setup 
Sound 
.... 

more ..,. 
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Data Exchange: Clipboard, Publish & Subscribe , PC Exchange 

® On 0 011 ( Options ... ) 

4 Type a suffix for a COS/Windows application. 

5 Double-click the matching application on the Mac. 

6 Click the pop-up menu to select a document type. 
.... 

7 Select the document type. 



Data Exchange: Clipboard, Publish & Subscribe, PC Exchange 

Each •ss~t bf.lov dfotHmlnu v hk h 
H~intosh ~ltc.ttion pr09f~ is usf'd v hton 

IJI ou opton OOS dowmtnts: vlth • p..trHoul.,. suffix . 

[ fldd... J [ Change ... J ( Rcmoue 

@ On Q OH (Op tions ... J 

To open a DOS or Windows file with an 
assigned suffix 

¥W#f¥i I pc disk ., 
2 ittmJ 47K in dWc 67!»( olV.tii.,OJ. 

~ 08-8314 .DOC ! 
p"'""""' .... 

~ ! 
1 Double-click the icon in the Finder. 

Company News 

Midi.OO Bank is hllppy to annoUJ"Cl! that Vice President Carol Wilson viii 
be promoted to the position of Senior Vice Pre.;ident of Commercial Loans 
effective June I, 1994. Carol joined the bank in 1982 as a Credit Analyst, 
1100 vas promoted to Loan Officer tvo years later. From 1987-1990 she 
vas Manager of our 2nd Street branch office. In 199 I she returned to 
head office as Vice Pre.;ident for Mortgage Loans and scttessfully 
implermnted many nev programs . In her nev position Carol viii report 
rurecuy to the Pre.;ldenll 

I 

The docuroent opens in Microsoft Word. 



Desk Accessories: Calculator, Key Caps, Note Pad, Puzzle 

Calculator 
The Macintosh Calculator has only four functions much like a sim­
ple pocket calculator-addition, subtraction, multiplication, and 
division. You also can create formulas on the Note Pad and then 
copy and paste them into the Calculator to compute them. A sam­
ple formula is 1082-36*54/6. You also can copy calculations from 
the Calculator and paste them into a document. 

1 Open the Apple menu and choose Calculator. 

liill File Edit Ulew Lobel Spec lol l 
About This Macintosh ••• 

~ Rlonn Clock 
S RppleCD Rudlo Player 
CJ Automated Tasks ~ 

~Chooser 'I: 

(i;;) Control Panels ~ 
~ Find File m Jigsaw Puzzle 
Gi]Key Cops 
r;:J Note Pod 
!Ill Puzzle 
~Recent Applications • (lD Recent Documents ~ 
lim Recent Seruers 
ll!l Scrapbook 
<j;l Stickles 
CJ Useful Scripts 
j • Shut Down 

~ 

2 Cl ick or type a value. 

3 Click or type a math operator (+, -, • or /). 

4 Continue to enter values and operators until you are finished. 

5 Press Enter or click =. 
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Desk Accessories: Calculator, Key Caps, Note Pad, Puzzle 

Key Caps 
Key Caps represents a map of the Macintosh keyboard and displays 
symbols and characters h idden from view when you press the ;u, 
Option, Shift, o r Contro l keys. Use these keys alone or in combina­
tion in your application to produce a special character o r symbol. 

1 While in a document, open the Apple menu and choose Key Caps. 

liiill File Edit Uicw Lobel Speclol l 
About This Moclntosh .•. 

~ Alorm Clock 
~ Apple CD Audio Ployer 
CJ Rutomoted Tosks ~ 

11!1 Colculotor 
~Chooser 
Qi) Control Ponels ~ 

lt Find File 
fHJigsow Puzzle 

ll:J Note Pod " 
~Puzzle 
Gil Recent Rppllcotlons ~ 
(lSI Recent Documents ~ 

f.im Recent Seruers 
~ Scropbook 
~ Stickles 
CJ Useful Scripts ~ 

II • Shut Down 

Current typeface 

more .,.. 
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Desk Accessories: Calculator, Key Caps, Note Pad, Puzzle 

3 Press Shift, Control, Option , Shift+Option, to view special characlers. 

48 

,-
Special Characters 

The followmg special characters are available 
from the Symbol t ypeface: 

.--------1~ .. . "' • • 'TM © + • 

5 Click to place the insertion point. 

6 Type the key combination you chose. 



Desk Accessories: Calculator, Key Caps, Note Pad, Puzzle 

Note Pad 
The Note Pad desk accessory that is now part of System 7.5 is an 
expanded version of the original. Although you cannot save Note 
Pad notes, you can now resize the Note Pad and print your notes. 

To create a note or adjust the Note Pad 

1 Open the Apple menu and choose Note Pad . 

g FIIe Edit Ulcw Label Special I 
About This Macintosh .•• 

~ Alarm Cl ock 
@lJ AppleCD Audio Player 
CJ Automated Tasks ~ 

8 Calculator 
~Chooser 
GEl Control Panel s ~ 

~ Find File 
~ Jigsaw Puzzle 
aij Key Caps 

~Puzzle 
~Recent Applications ~ 

(lSJ Recent Documents ~ 

~ Recent Seruers 
11!1 Scrapbook 
~Stick les 
CJ Useful Script s ~ 

I • Shut Dow n 

Move the Note Pad by dragging the title bar. 

2 Type a note . 

Note Pad 

To Do List , July I B, 1994 

1. Send Joyce Chin e congretul etory not e. 
2. Send Gui do Cerott en invttetton t o the Mecromedie meeting. 
3. Cell Bryn Mooth et HOW Megezine. 
4. Cell Rite wooderd et Aldus. 
5. Check Compuserve s-mell messages. 
6. Purchase high densi ty di skettes. 

Click the turned-up corner to tear oil a note. 

Drag the 
resize box 

to reshape a 
note. 

Click below the turned-up corner to view the previous page. 

3 Close the Note Pad by clicking the Close box. 
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Desk Accessories: Calculator, Key Caps, Note Pad, Puzzle 

To change the typeface of text on the Note 
Pad 

50 

2 Open the Edit menu and choose Preferences. 

r .... file 11!111 • 
Undo llllZ 

Cut llllH 
Copy llllC 
Past e llllU 
Clear llllB 

Find •.• llll f 
find Ago in llllG 

Sel ect All IIIlA 

3 Open the Font pop-up menu. 

Preferences: 

font I 6eneua ·.1 

Size C!:EJ 

[ cancel l c::E:J} 

4 Choose a typeface. 

Rpple Chancery 
Chicago 
Courier 

Hoefler TeHt 
Hoefler TeHt Ornements 



Desk Accessories: Calculator, Key Caps, Note Pad, Puzzle 

Note with the new typeface 

Note Ped 
f o Do U•t. ~ 13, 1994 

t Send ..1¥• Ct*l o corvotuatay not.. 
2. Send GUdo Coro~ on lr1'At.otlon IQ Ill< Mocrom«h "'"~ 
3. Cal &<)n Mooth •• HOW Mag>""' 
• · Cal ~t.o Woodard • • AlG\J> ~ Puwoslon ~ 
~. Chect CD"""'..w .. ~ ~ 
6 . P~rc~>••• ~ dcnolt¥ d•k..U.I 

I 

To print a note 

0 
II 

1 Open the File menu and choose Print Current Note. 

IIIIDI Edit 
New Not e MN 
Cl ose MW 

Go To Note ••• 
Delete Note ••• MD 

Pege setup ••• 

Print one MP 

Quit MQ 

Pr inter "'LaserWrlter I I NT " 

Copies: [Q] Pages:® All 

Couer Pege: ® No 0 First Page 0 Last Page 

Poper Source:® Poper Cossette 0 Monuot Feed 

Destination: ® Printer 0 Disk File 
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Desk Accessories: Calculator, Key Caps, Note Pad, Puzzle 

To delete a note 

1 Open the File menu and choose Delete Note. 

I ~ 1111!11 Edit 
New Note !I:N 
Close !I:W 

Go To Note .•. 
I· • . I 

PDge Setup ••• 
Print. •• 
Print One !I:P 

Quit !I:Q 

li\ nre you sure you want to permanent ly 
~ delete the current note? This operation 

i s not undo- able. 

To quit the Note Pad 

1 Open the File menu and choose Quit. 

I ii lima Edit 
New Note X N 
Close !I:W 

Go To Note ••• 
Delete Note .•. X D 

Page Setup ••• 
Print ••• 
Print One X P 
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Desk Accessories: Calculator, Key Caps, Note Pad, Puzzle 

The Jigsaw Puzzle 
Apple's new puzzle has sound effects, and you can create cus­
tomized puzzles with pictures of your own. If you plan to paste a 
picture o f your own, make a copy o f the Jigsaw Puzzle so that you 
can restore the origi nal picture. 

To start a new puzzle 

m rue Edit Uiew LGbel Speci GI I 
Rbout This MGt lntosh ... 

~ RIGrm Clock 
8 RppleCD Rudlo PIGyer 
C1 RutomGted TGsks • !3 CGICUIGtor 
~Chooser 
(1;£) Control PGnels • ~Find File 

~Key CGps 
()Note PGd 
il Puzzle 

1 Open the Apple menu and choose Jigsaw Puzzle. 

2 Open the Options menu and choose Start New Puzzle. 

Show Picture 
Solue Puzzl e 

A BC D E F G H I 

J L M N O P Q R 

S U V W X Y Z 

Choose Piece Size: 

0 SmGII 

® Medium 

0 LGrge 

more ..,. 
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AB < D E F 

J L M N 0 

s L_; 

H I 

To add your own graphic to the Jigsaw 
Puzzle 

1 In a paint program, select a graphic. 

3 Quit the paint program. 
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Desk Accessories: Calculator, Key Caps, Note Pad , Puzzle 

File Edit Ulew label Special 
About This Macintosh ..• 

~ Alarm Clock 
f!!!l AppleCD Audio Player 
CJ Automated Tasks ~ 

E) Calculator 
~Chooser 
(;;;)Control Panel s ~ 

6 Find file 

5 Open the Edit menu and choose Paste. 

r • f ile 11111111 Option 
Undo 11€2 

Cut lleH 
COP II lillC 

Clear" 

New puzzle 

To solve the puzzle automatically 

1 Open the Options menu and choose Solve Puzzle. 

r • file Edit 
Start New Puzzle ... aiN 

.-Use Sound Effects alE 
Set Background Color. ICB 

Show Picture 

more ..., 
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To quit the Jigsaw Puzzle 
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Disks: Hard Disks, RAM Disks, Floppies, CD-ROM 

Managing Hard Disks 
A disk cache is an area in RAM that stores info rmation frequently 
needed from d isk. A "startup" disk requires a System Folder but 
does not need to be your internal hard drive. Extra space on your 
hard drive may be put to use as "virtual" RAM memory. To speed 
up opening files o r launching applications, you may want to 
allocate more memory to the disk cache. 

To adjust the disk cache 

9 

e 

~ 

v7 ,3 

@) AppleCD Audio Player 
D Automated Tosks 

Capture 
Color 

l!ll Calculator 
~Chooser 
I!!S [ontrol Pdn•l• 
10; Find File 
~ Jigsaw Puzzle 
IAJ Key Caps 

Colorsync'" Syst em Profile 
Dote I} Time 
Desktop Patterns 
DDS Mounter Plus'" 
EM tensions Monoger 

D Moil ond Catalogs 
[J Note Pod 

File Shoring Monitor 
General Controls 
Keyboard IS<! Recent Applications 

(iS] Recent Documents 
(&;] Recent Sewers 

labels 

Db> C..... 
Alv~s On 

vrt~l~ 

00n 
@Off 

RAMOb:k 

QOn 
@orr 

1:::--: ~nc)n1o~h UO ... , 

Anmtl\t on dm< : 229M 
Anilablt- built- II mtmOt"V : 24M 

PHCHit of .ilv ,.fl•bho ll"ltfT''If'1J 
to uu fOf" <1 RN1 disk : 

®"~--~-:1< 
0$ 509iS 1oogs 

RAM Disk Siz:. [gg:::] 

I Use Defaults J 

4 Click the Close box. 

5 Open the Special menu and choose Restart. 

I • File Edit Uiew LaDe I lllilimilll 
Clean Up Deskt op 
Empty Trash ... 

Eject Disk liSE 
Erase Disk .•. 

l"mot •.• 
lock Key Choln 

.. 
Shut Down 
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Disks: Hard Disks, RAM Disks, Floppies, CD-ROM 

To change the Startup disk 

58 

Jigsaw Puzzle 
Key Caps 

CJ Mall and Catalogs 
[,;:)Note Pad 
~ Recent Applications 
(l5] Recent Documents 

Seruers 
k 

wn 

... 
ColorSync'" System Profile 
Date & Time 
Desktop Patterns 
DOS Mounter Plus'" 
EHtenslons Manager 
File Sharing Monitor 
General Controls 
Keyboard 
Labels 
Launcher 
Macintosh Easy Open 
Map 
Memory 
Monitors 
Mouse 
Network 
Numbers 
PC EHchange 
PowerTalk Setup 
Sharing Setup 
Sound 

2 Choose Control Panels, Startup Oisk. 

~ 
Mll'40riY• ¥ tl'll w !TIIItt 

• """"" 



Disks: Hard Disks, RAM Disks, Floppies, CD-ROM 

To use hard drive space as memory 

2 Choose Control Panels, Memory. 

@it AppleCD Audio Player 
CJ Automated Tusks ~ 

8 Colculotor 
~Chooser 
I'J!l Control Panel< 

~ Find File 
~ Jigsaw Puzzle 
(jjJ Key Cops 
CJ Moll and Cotol ogs ~ 

!;J Note Pod 
(2) Recent Applications 

ClsJ Recent Documents 
~Recent Seruers 
Ill Scropbook 

Stickles 
• Shut Down 

3 Click Virtual Memory On. 

ATM'" GH 
Auto Power On/ Off 
Capture 
Color 
ColorSync'" System Profile 
Oate & Time 
Desktop Patterns 
DOS Mounter Plus'" 
EHtenslons Manoger 
File Shoring Monitor 
General Control s 
Keyboard 
Lobels 
Louncher 
Macintosh Easy Open 

Mouse 
Network 
Number s 
PC EHchunge 
Powerlolk Set up 
Shoring Setup 
Sound 

S.lfct HM d Disk: 

I= Macint osh HD ,I 
Av.alt..b,. on d isk : 229M 

Av .aib bt. built-n ~v : 24M 

of .av.ailtblt mtmor\j 
toust fOf' .a RN1 difk: 

00n 
@ off 

GJ;:::::::::::;::::::::::::::::>I 
09li :so~ 100~ 

RAMOif-k Sin ~ 

v7.3 

5 Click the Close box. 
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Disks: Hard Disks, RAM Disks, Floppies, CD-ROM 

Using a RAM Disk 
A RAM disk is an area o f RAM memory tha t the computer t reats like 
a disk drive. It's noticeably faster than a disk drive. Be careful to 
back up frequently, however, because RAM memory is vola tile and 
can be lost if there's a power problem. 

To create a RAM disk 

~ Rppl eCO Audio Player 
CJ Automated Tasks 
IS Cal culator 
~Chooser 

~ rnnholl' t~ nr> l \ 

~Find File 
~Jigsaw Puzzl e 
l'iJ Key Ceps 
CJ Me II end Cet elogs 
h::J Note Ped 
~Recent Rppllcetlons 
CllJ Recent Documents 

lilll Recent Seruers 
11!1 Scrapbook 

Stickles 

Apple 
ArM'" GH 
Auto Power On/ Off 
Capture 
Color 
Col orsync'" System Profile 
Dele & Time 
Deskt op Patterns 
DOS Mounter Plus'" 
EHi enslons Meneger 
File Shertng Monitor 
General Controls 
Keyboard 
labels 

~-Hili l~:f!H'JIIIlil~lm. 

• M emory 

S: 0 kC""' C.ol'ltSiu !ill[] liD "W'~t On 

S.ltet Hlt'd Dllk : 

~ 
y tu•lt1tfnor'v I= Mnr.lnl<"h 110 .. , 
<Dan Av•fl.t>lt on dilk: 229N 

~ Off Anfllblt bunt- tn tnttnOr"' : 1o4M 

Ptt"cf nt of eve l1tblt m.mory 

~ pt.. ouk to USt (Of' t RAM dbk: 

Cl) ~~~ --w 
Oll f-. 100!1 

RAMOUk sl t ~ ,_, 
v7.3 

l UseD faults J 

4 Drag the slider to choose a percentage of avai la 

5 Click the Close box. 

ble memory. 

6 Open the Special menu and choose Restart. 

[ oi File Edit Ulew Lebel li1IIDillll 
Clean Up Desk top 
Empt~ Trosh ... 

Eject Di sk X E 
Erase Olsk ... 

I 'm et. .. 
lock Key Chain 

Shut Down 

60 



Disks: Hard Disks, RAM Disks, Floppies, CD-ROM 

To remove a RAM disk 

2 Select the contents and drag them outside the window. 

~ Find File 
~ Jig sow Puzzle 
Gl) Key Cops 

CJ Moll ond Cotologs 
b:J Note Pod 
~ Recent Rppllcotlons 
Cl:i:J Recent Documents 
(im Recent Seruers 
[l!i Scropbook 
<$'Stickles 

• Shut Down 

Speclol 

Apple Menu Options 
ATM'" GH 
Auto Power On/ orr 
Copture 
Color 
ColorSync'" System Profile 
Dote & Time 
Desktop Potterns 
DOS Mounter Plus'" 
EHtenslons Monoger 
file Shoring Monitor 
Gener ol Controls 
Keyboord 
lobels 
Louncher 
Moclntosh Eosy Open 
Mop 

Monitors 
Mouse 
Network 
Numbers 
PC EHchonge 
PowerTolk Setup 
Shoring Setup 
sound 
.... 

4 Choose Control Panels, Memory. 

more..,. 
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v7.3 

Memory 

j CJ Mne)n1 o~h UO ,..I 
~v~il•b~ on d isk: 229M 

" v•il.abl• bullHn rMmory : 2411 

@;:=. ~ .. --1• 
0~ ~9'6 IOO'JI! 

RAM ObkS iu 

( Use Defaults ) 

5 Click RAM Disk Off. 

Handling Floppy Disks 
Disks may be sold preformatted fo r Macintosh or IBM PCs. Because 
bo th wi ll mount on the Macintosh, be careful to watch for a PC 
logo o n the disk. If the PC logo is there, the disk is preformatted for 
an IBM PC. 

To format a floppy disk as Macintosh or DOS 
format 

1 Insert the new floppy in the disk drive. 

If you see a PC disk icon 
appear on the Desktop, 

the disk has been 
formatted as a DOS -~ 

disk. To reformat as a 
Macintosh disk, see 'To 

erase a floppy disk." 
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3 Choose Macintosh or DOS format. 

lnlllellzlng will e rose oil 
lnf ormotlon on 1hh dhk. 

4 Click Initialize. 



Disks: Hard Disks, RAM Disks, Floppies, CD-ROM 

To eject a floppy 

1 Click the disk icon to select it. 

To erase a floppy disk 

1 Make copies of the files you want to keep. 

The name of the disk is highHghted. 
Type a new name if you want to 

change the name of the disk. 

Completely e 
" Mac Records 

4 Choose a format. 
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Disks: Hard Disks, RAM Disks, Floppies, CD-ROM 

Handling CD-ROM Discs 
Apple's CD-ROM drive will read discs that have been formatted as 
HFS (used by Macintosh), IS0-9660 (used by MS-DOS computers) 
and the High Sierra fo rmat, a predecessor o f the ISO 9660 format . 

To open a PC or Macintosh CD-ROM disc 

1 Double-click the CD-ROM disc icon. 

To eject a CD-ROM disc 

Close Window lEW 

Get Info 311 1 
She ring ... 
Duplica t e :J!lD 
Meke RliGS 311 M 

Find ... 311 F 
Find Rgoln 311 G 
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LJ 
S\lsttmSiuff 

PC fi les saved to a CD-ROM 
disc may need to be copied to 
the hard drive and translated 
before they can be used on a 

Macintosh. 



Setting Up PowerTalk 
Software 
Althoug h PowerTalk is an option that you may o r may not want to 
install because of extra memory requirements, many small busi­
nesses benefit from mail service that does not req ui re a dedicated 
server. Peer-to-peer mail means e-mail can be sen t back and forth 
between two o r more computers. 

To open your PowerTalk Key Chain 

Ulew 
About This Meclntos 

2 Choose Control Panels, Date & Time . 
-------------------

ell Apple CD Audio Player 
D Automoted Tosks ~ 

1m Colculotor 
~Chooser 

Apple Menu Options 
ATM'" GH 
Auto Power On/ Off 
Capture 
Color 

[Htenslons Menoger 
file Sherin Monitor 

3 Check to make sure dale , lime, and lime zone are correct. 

D Daylight Seulngs Time 

( Set Time Zone ... ) 

ell AppleCO Audio Ptoyer 
D Automated Tosks ~ 

1:11 Colculotor 
~Chooser 

!!i ( ontr ol PdRPI\ 

~find file 
~ Jlgsow Puzzle 
~Key Cops 
D Moll ond catalogs 
rJ Note Pnd 
@)Recent Applications ~ 

Ci:tJ Recent Documents ~ 

ria Recent Seruers 
~Scrapbook 

<f1 Stickles 

~ Menubor Clock 

@On Q Off 

( Clock Options ... 

RTM'" GH 
Auto Power On/ Off 
Copture 
Color 
ColorSync'" System Profile 
Dele & Time 
Desktop Potterns 
DOS Mounter Plus'" 
EHtenslons Manoger 
File Shoring Monitor 
General Controls 
Keyboard 
Labels 
Launcher 
Macintosh Easy Open 
Map 

more.,.. 
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66 

7 Open the Special menu and choose Unlock Key Chain. 

I • File Edit Ulew l abel llmiZI!!III 
Clean Up De•ktop 
Empt y Trash ... 

Eject Disk ~ 

Erose Disk ... 

I'm at ... 

Restart 
Shut Down 

8 Click Proceed. 

Welcome to Power, a1k TM 
u.. 1\polt ()ptn Coll-• tlon r.vr""" t 

The PowerTalk Key Chain lets you access m llple 
seruices using just one Access Code. 

Cancel J f Proceed ;8 
~f'iltlt 1 989-- 1 993,App~ ~.,.. w.c. 

9 Click Yes if you have a PowerShare server account. 

C:::O You can now add the key for yo r 
PowerS hare seruer account. 

10 Click No if you do not. 

If you are unsure whether you have a PowerShare 
server account. see your network administrator. 



~ To prevent unauthorized use, your Key Choln 
Is protected by on Recess Code. 

Please pr?ulde your nnme end Recess Code: 

Name: IMel 
I 

Recess Code: I•••••• I 
~ 

( Cancel ) -fi OK J 

11 T ype in an access code. 

liJ' ... H rH~I 

13 Reenter your access code . 

certain you 

Access Code; 

new Access Code to make 
correctly the first time. 

~ Your Key Chain will be pieced In the Apple menu. 

To change your Access Code or to add keys, open your Key 
Chain. 

Make sure ell the Information In the Onte & Time control 
panel Is correct nnd that the Machine Name In the Sharing 
Setup control penells specified. 
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E-Mail: PowerTalk, Information Cards, Catafrigs:~·· · 

To delete the record of the PowerTalk Key 
Chain 

4 Open the Special menu and choose Restart. 

[ • f ile Edi t Ulew Lobel llmi!IDI 
Cl eon Up Deskto 
Empty Trosh ... 

Eject Disk • Erose Di sk ... 

I'm ot... 
l ock Key Choln 

Shut Down -~ 
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To turn the Access Code prompt and mail 
on or off 

1 Open the Apple menu. 

2 Choose Control Panels , PowerTalk Setup. 

liiiill f ile Edit Ulew Lebel SpetleiJ 
Abou t This Metlntosh ... 

Apple Menu Option 
@l) AppleCO Audio Player ATM~ GH 
(]Automated Tesks ~ Auto Power On/ Off 

EJ Celt uletor Capture 

~Chooser Color 
Colo~ynt- Syster Profile .. 
Oete &Time 

~ find f ile Desktop Pettems 
~ Jig sew Puzzle ODS Mounter Plus" 
GJ Key Ceps EHtenslons Meneg r 
(]Me II end Cotologs ~ file Sharing Monll r 
[,J Note Ped General Controls 

(Sg Aetent Applltotlons ~ Keyboard 

(iSJ Aetent Documents ~ 
Label s 
Leunt her Ill Aetent Seruers Metlntosh Eesy Op n 

Ill Strepbook Mep 
<f' Stltkles Memory D• Shut Down Monitors 

Mouse 
Net work 
Numbers 
PC EHthonge 

' 
Sharing Setup 
Sound ... 

3 Click the X on or off. 

l ode 1<~ Chai'l .tf1tf" Dminutts of ln~tivif\1 . 
Aslc f<r Kto~J ChaW\ ~u ~at st.-tup . 

To .oct sHVicH or c:f'wn9t vo..r 
~ssCoc»,CIPM!lOAI'PO'Wtt'T-il: 
Kt\1 Ch&fn. 

Key Chein ... 
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E-Mail: PowerTalk, lnformatio~ 

To lock the Key Chain 

1 Open the Special menu and choose lock Key Chain. 

I' File Edit Ulew Lobel &!!!!!IIIII" 
Cleon Up Desktop 
Empty Trosh ... 

Eject Disk !U 
Erose Disk ... 

I 'm ot ... 

Res tort 
Shut Down 

To unlock the Key Chain or change mail 
services 

70 

1 Open the Special menu and choose Unlock Key Chain. 

loi File Edit Ulew Lobel Kmllllllll 
Cleon Up Desktop 
Empty Tr osh ... 

Eject Disk leE 
Erose Disk ... 

I'm ot ... 

Restor ! 
Shut Down 

Q To unlock your Key Choln, enter your Recess 
1l Code: 

Nome: Mel 



E·Mail: PowerTalk, Information Cards, Catalogs 

To open the AppleTalk catalog 

I •·1'®@111@0!.1.~JH.!.1•1 ''"""''~H• 

• 

The Apple Talk catalog provides a list of all computers on the Apple Talk network . 

tJM Rpp!eTa!k . ~ 
Cl1, !!!!!!t K'"' 
~ HNy .Jo's C~ttf AppltShw-t f1lt strvtr 0 

~ MM-v .Jo's Computtf Dirtct Ac~P\tTalc Nil ... 

~ Mtrs ComptJttr AppltShwt fnt SNYtf" 

~ Mtl'sCotnc~Ytw Oirtct AppltTal< maH ··· l{j 
!<: Iii 
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E-Mail: PowerTalk, Information Cards, Catalogs 

Sending and Receiving Mail 
With PowerTalk installed, you can send mail to and receive mail 
from any com puter on an AppleTalk network. Even if a user has 
collaborative services turned off, their mail will be delivered when 
services are turned on. 

To create an e-mail message with an 
enclosure 
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E-Mail: PowerTalk, Information Cards, Catalogs 

Ill! lffil.il'illllll'illl-'111'1111 

1 untmeo· 
v 1!1•·- -jHI 

l lr• 

I I 
1!1 ~Eae1osv•• 

l<i I ~ 

s Click to select a recipient's name. 

@J 
• ~~~---,:'i 
[@ 

~ '-------== 

7 Click Done. 

12! M"'J Jo'J Co<no-IH To ;!! 

9 Click the Enclosures icon. 

more ..,. 
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E-Mail: PowerTalk, Information Cards, Catalogs 

10 Select a file to enclose. 

)eii snmele rues ...- 1 = Mnclnto•h HO 

CJ Ar t file s 0 [ [jeri I 
[]Artwork 

[ Des ktop ) ~Mel, e-mnll, 6/29/ 9 4 
®)Script. POD 

( Enclose;) CJ Shnred folde r 
-..., ~ ~Uolce-ouer 

jo1 Z Script {)o l Open J 

Sele ct o file or folder to enclose I Concel J 
with the le tte r . 

11 Click Enclose. 

1!2JRoclp ... ts 

I 'i1 Yo;o...o...-

13 Type a message. 

• ntltled- 1 • 
~ FrOM Mtl S..jKt Yob-ovtr , ttli.lltWntdia " Mory Jo: ;!,! 

Just a remirxler coocerning the multimedia voice-over session scheduled for 
July 5th at 3:00p.m. Susan arxl Sieve v iii record using the Quardra 840AV 
v ith the machine's built-in microphone. We'll record straight to disk arxl 
avoid analog tape. 

I've just received the upgrade of SourxlEdit Pro softvore vhich is nov 
16-bit sourxl. 

Please confirm that you can join us at that session. 

Mel 

~ 7i 
IQL I ~~~ 
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To save an e-mail message 

1 Create an e-mail message. 

2 Open the File menu and choose Save . 

I .0 IIJlill Edit Font Size Style Formet M e II Windows_! 
New 88N 
Open ••. leO 
letterheeds ••• iel 
Close sew 
Del ete 111m 

Seue As ••• 
Seue As l e tterheed ••• 
seue As TeHt. .. 

Pege Setup ••• 
Pr int ... ieP 

Quit ieQ 

4 Type a name. 

5 Click Save. 

To send an e-mail message 

1 Create an e-mail message. 

more ~ 
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E-Mail: PowerTalk, Information Cards, Catalogs 

Send document "E-Moll, Mary Jo/ 60/ 30" 

Send os: I RppleMoll "" I D Sign Letter 

Priority: 0 High 
®Normal 
Q low 

[E New moll hos orriued ror Mory Jo. 

OC~tl 

A mall arrival message alert appears on the screen of the recipient. See the 
section "To set Mailbox preferences" to adjust how mail arrives. 

To quit e-mail 

1 Open the File menu and choose Quit. 

I ii IDJiiii Edll Font Size Style Format Moil Window$] 
New X N 
Open •.. IIIlO 
Letterheads ... X L 
Close xw 
Delete :!1:0 

Saue xs 
SoueRs ... 
SoueRs l etterhead ... 
SoueRs TeKI... 

Page Setup ••• 
Print ... X P 

OUit • 0 
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To set Mailbox preferences 

l' •l'"@ll,®lmi!·""·'·'·IJ·"" 

• 
2 Open the Mailbox menu and choose Preferences. 

I oi File Edit Ulew l abel Speclnl 
v' In Trny 

Out Trny 

Mark Unread 
Tag •.. 
Copy l ocal 
Send Now 

3 Add or remove Xs to turn preferences on or off. 

Out Tr i!J A9in9: 
R•mov. Pf""OC.SStd lttms ~fttr ~ d~s . 

T.tgs List: 

I EdL I 
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E-Mail: PowerTalk, Information Cards, Catalog~;~ 

To collect your e-mail 

l l •lillliF@IIiljlf'mii·1•11•1·1·!J·118 

• 

E-mail messages may be saved on your hard drive. 

llolce-ouer, mulllmedlo6 30 94 
~ fre.Htrt:~ ._,..t Yoiot-oT.,..#mutttntdb 

t.iary Jo: l1l 
Just a remimer concernin,g lbe multimedia voice-over session scheduled for 
July 5th at 3:00p.m Susan am! Sieve viii record using lbe Quardra 840AV 
vith lbe machine's built-in micropb:me. We'll record straight to disk am! 
avoid analog tape. 

I've just received lbe upgrade of Sound Edit Pro software vhicb is oov 
16-bit sowrl. 

Please confmn that you can join us at that session. 

Mel 

to 
I• 
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~ · ... , · · ___ .,_, E-Mail: PowerTalk, Information Cards, Catalog~ 

To open and save an enclosure 

a rerrunder concerning the mutluned1a vo1ce-owr session scheduled for 
5\hat 3:00p.m . Susan and Stew v11l record usmglhe Quadra 840AY V llh 

· · bwlt-in microphone We' ll record straight to disk and avo1d analog 

I've just received the upgrade of Sound Edit Pro softvare v hich is nov 
16-blt sound . 

Please confirm that you can join us at that session. 
Mel 

S..t 2'9, .An 1994~ 10:18 PM 

In order for application fi les to open, the application software must be present. Consider 
creating portable digital documents that do not require application programs to open. 

more ... 
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E-Mail: PowerTalk, Information Cards, Catalog~;~,:L -
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4 Select a folder to save the document. 

Stme Current Document es: 

= Macin tosh HD 
4242K auolloble 

6 Click Save. 

7 Open the Fi le menu and choose Quit. 

I ~ IDIIJI Edit Ulew Insert Format Font Tools Window I 
New !liN 
Open .. , :111 0 
Close :!IIW 
soue 3!1S 
soue As ... OF7 
Find File •.• 
summary In fo .. 

Print Preulew .. , ~I 

Poge Setup ... oro 
Print ... 3!1P 
Print Merge ... 

I I 



E-Mail: PowerTalk, Information Cards, Catalogs 

To change your Mailbox name 

§ Rpplero Audio Pleyer 
D Rutomoted Tosks • 
EJ rolculotor 
~ rhooser 
1!9 [onlrol Panel\ 
~ Find File 
~ Jigsaw Puzzle 
(jjJ Key raps 
D Moll ond [otologs 
r,;:] Note Ped 
~Recent Applications 
(iS) Recent Documents 
fill Recent Seruers 
Ill Scropbook 

Stickles 
• Shut Down 

ATM'" GH 
Auto Power On/ Off 
[opture 
[olor 
[olorSync'" System Profile 
Dote & Time 
Desktop Pottems 
DOS Mounter Plus'" 
£Htenslons Moneger 
File Shoring Monitor 
General [ontrols 
Keyboerd 
Labels 
Launcher 
Macintosh Eosy Open 
Mop 
Memory 
Monitors 
Mouse 
Network 

2 Choose Control Panels, Sharing Setup. 

4 Type in an alternative name. 

5 Click the Close box. 
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Using Aliases and the Find 
File Commands 
In the Macintosh operating system, folders represent directories 
and subdirectories. Finding applications, folders, or fil es among the 
many folders on your hard drive can be simplified by using aliases 
and the Find Fi le command. 

To create an alias and add the item to the 
Apple menu 

1 Click the icon . 

The alias icon 

the alias to the Apple Menu Items folder. 

LJ 
AutoSt¥1. St•t~ 

~~~~----4a 
fficr010ft Yorks 4 .0 
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To find the original of an alias 

1 Click the alias to select it. 

3 Click Find Original. 

0Loebd 

A window opens showing the original icon highlighted. 

To open a recently used application 
or document 
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To use the Find File command 

1 Open the Apple menu and choose Find File. 

~File Edit Uiew Lobel Speclolj 
Rbout This M ocln tosh ... 

~ RppleCD Ru~lo PI oyer 
li3 Col culotor 
~Chooser 
Q;) Cont ro l Po nels ~ 

' 
~ Jigs ow Puzzl e 
lEI Key Cops 
"t Key Choln 
CJ M oll ond Cotol ogs ~ 
r.J Not e Pad 
C?iJ Recent Rppllcollons ~ 

mJ Recent Documents ~ 
Ill Scr opbook 
<f1 Sticky Memos 
D Useful Script s 
'i • Shut Down 

~ 

4 Scroll the list of found occurrences . 

• Find File Results - Slu K ... Last Hocttfltd 

D OuieK....,, .. ~t~~ "" Sp.Kh HKro Edftor doc. .. 6/14/93 12!.10N1 ~ 
0 "'"'..,.(OK S<r'<>t ex.,..,..) .. ~ltT.xt docuntn1 6/14/93 12:00 N1 

OIM S<r'<>t "" A(lp1t5c:r"11t .. docl.mtnt 4/6/93 I 2:00PM 

CJ Son-o>"S<r'<>" . ,,_ 3/29/94 I 0:02PM J.. 

--l ~-- "" NicrMOft Vord docvntftt 6/28/94 I 2 :48PM 
<liS<r'<>t[- IS31C ~PS~~tXInprOCJ"¥'1 4/6/93 12:00 Pt1 ~ ..._ 
<::)l"1iot''tosfiiC> 

OS<r'<>• 
:!,! 

" 
f OIIId 16 lttmS .. 

The item's location 
5 Click an item to see where it is located. 
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4K SimpltTtxtdocuntnt 6/14/93 

4K AppltScrifl.,. ~t 4 /6/93 

fo\dH 3/29/94 

4K H;croJoft Vot"d docc.1mHtt 6 /28/94 

1~3K 4 /6/93 

Double-cl icking to open the document may not work with every application. 

Using Applications 
Applications run in RAM memory, and the more memory you 
have, the more applications you can run at the same time. Use the 
Application menu to switch between the programs you have open. 

To open an application 

To open an application automatically 
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4 Drag the Alias to the Startup Items folder. 

l oi File Edit Uiew Lobel lmZiml 
Clean Up Desktop 
Empty Trash ... 

Eject Disk 38E 
Erase Disk ... 

rm at... 
Lock Key Chain 

Shut Down 

5 Open the Special menu and choose Restart. 

The appl ication you chose opens automatical ly 
each time you start the computer. 

To avoid an accidental switch out of an 
application 

••·H1·""fn1in•• 
_.~FI-Ie~E-d-it--Ui_e_w~L~ab_e_I_S~p-e-c i-,al 

About This Macintosh •.• 

2 Choose Control Panels, General Controls. 
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(i9 RppleCO Audio Player 
CJ Automated Tasks ~ 

8 Cal culator 

~Chooser 
1!1!1 Control Panels 
~ Find File 
~Jigsaw Puzzle 
Gil Key Caps 
CJ Mail and Catal ogs 

(J Note Pod 
~ Recent Applications 
(]D Recent Documents 

Recent Seruers 

Apple Menu Options 
ATM'" GH 
Auto Power On/ Off 
Capture 
Color 
ColorSync'" Syst em Profl e 
Dote & Time 
Desktop Patterns 
DOS Mounter Plus'" 
EHtensions Manager 
File Sherin Monitor 

Keyboard 
Labels 
Launcher 
Macintosh Easy Open 
Mop • 
Memory 
Monitors 
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~-HITil11i .. ~, iTi'IT.'III lUll Ill 

Generol Contro ls 

r < ~·kl•p 

1:1 
- lnstrtion Potnt Blinktng -

0 Shov C>tsktop ..,htn in b•ck9r"Ovnd ... . , 0 ® 0 
~ Slow Fut 

l81 Show L•U'JoChtf'" •t svstt m st•rtup • - M•nu B1lnkin9 

II ~ Shut Down Vuntn9 

. 
0 0 ® 0 

I Off 1 2 3 - t8J 'rt'.,.n m.lf computH VIIS shut dovn in'VOPHIIJ 

i Fo1d•r Protec tion r Ooot~menb 

(8l Prottct Svsltm Foldtr ~ Vhto optt1in9 Of' uvir~Q • dOCU"'"'tftt, bb m. to 

0 Fokttr vMch QCf\h V\S tM "P'Plic.• tion. 

[8J Prottet Appl'lc•tiotlf foldtr ~ 
® lut fokttr usl'd in thfo applicahon. 

O~ts foldtr. 

To change an application's memory size 

New ... 
Open ... 
Close 

Soue 
soue As ... 

MS 

Sel ect ion to TeHture ... 
Reuert to Soued 

Piece EPS 
EHport ... 

Document Info ... 
Poge Setup ... 
Print... MP 

3 Click to select the icon. 

4 Open the File menu and choose Get Info. 

more .,. 
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~ A~s~P•Wit 
" Aldus SupH"Po~W!tf) Vtt'"sion 3 0 

IC'-41 : .applieo~Honpr091"Mn 
Siu : 1 f"SondiJk(1.~,044~t.-s 

uud) 
v..--.-. : M..e1ntolh tl> : .t_pphc•Uons: 

~P.aY'It : 

Cruh·4 : So~~t , Stp 14, 19'91, 12.00 PM 
HHlfif.d:S.,.,"""'26,1~, 12:$)PM 
Y•rsM: 3.0, () 1996, 1988 • 1991 , 

Silicon Bt.ch Son ... .,. ... ~. 

To switch between applications or to 
check which are open 

1 Open the Application menu. 
1:15PM I":JD 

Bide Aldus SuperPalnt 
Hide Others 
Show All 

Using the Launcher to Open 
Applications and Documents 
In the Lau ncher, applications and documents open with a single 
click. The Launcher may be customized to hold your software or 
documents and set to appear automatically on startup. 

To open a document or application using 
the Launcher 
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® AppleCO Rudlo Ployer 
CJ Automated Tosks 
(ll Cal culator 
~Chooser 
1!!J l onlr ol Pdnel• 
~ Find File 
~ Jigs ow Puzzle 

Copture 
Color 
ColorSync' " System Pro m e 
Dote & nme 
Desktop Patterns 
DOS Mounter Plus~ 

Gil Key Copsc,lll=~~~~~~~ CJ Mollond 
(I Note Pad 
~ Recent Appllcollons 
(jj] Recent Documents 
lim Recent Seruers 
Ill Scrapbook 

Stickles 
• Shut Down 
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To add an item to the Launcher 

To remove an item from the Launcher 
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To show or hide the Launcher at startup 

(J Automated Tasks 
E) Cal culator 
~Chooser 
1!1!1 Control Panel\ 
~Find File 
[B Jigsaw Puzzle 
Gil Key Caps 
D Mall and Catalogs 
b:J Note Pad 
(2) Recent Applications 

Ruto Power on/ orr 
Capture 
Color 
ColorSync•• System Profile 
Date & Time 
Desktop Patterns 
ODS Mounter Plus'" 

Generel Controls 

r •·~•••• 

18 1"""'"""""'-~-...~ 

~Sho"W LIUI'IChtf' ~~ s-.~sttm stwtup 

(BJ Prot~t S.,s ttm Foldtt' (f) 
[8) Prott<:t Apphc:• ttons fo\ckor (lJ 

- H .. uBIMhot 

m o o ® o 
1

11110ff123 

'------ - ----' 
r oec-Mb ----- -----., 

Yhtn optnin9 fW' uvh;J • doeunwnt, Uk• m. to 

0 roldtt' wf'lioh contain• tht ~Hc•Uon. 

® Lut foldtf' vstd fn tt1ot ~~tion. o--. .. ,,_ 

Using Folders 
Folders a llow you to o rgan ize your ha rd drive. Create fo lders and 
name them so that you' ll remember what's ins ide. 

To create and name a folder 

1 Click to select a window lor the folder. 
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3 Type a name. 

4 Pres s Enter. 

rDiml Macintosh HD Jiii;:;lll 
t~itttru 79.1 MBindlsk 176.9 He 

t!!n~ 
I!! 

14$ 
I:' I 

To specify where items will be saved 

1 Open the Apple menu. 

2 Choose Control Panels, General Controls. 

File Edit Uiew Label Special 
About This Macintosh ••. 

ell Apple CO Audio Player 
CJ Automated Tasks • 
f3 Calculator 
~Chooser 

~Find File 
a:! Jigsaw Puzzle 
~Key Caps 

Apple Menu Options 
ATM- 6H 
Auto Power On/ DH 
Capture 
Color 
ColorSync'" System Profile 
Date~ Time 
Desktop Patterns 
DOS Mounter Plus'" 
EHtenslons Manager 

CJ Mall and catalogs 
r;:J Note Pad 

• File Sharln Monitor 

Ill Recent Applications • 
ClD Recent Documents • 
~Recent Seruers 
Ill Scr apbook 
~Stickles 

• Shut Down 

Keyboard 
Labels 
Launcher 
Macintosh Easy Open 
Map 
Memory 
Monitors 

3 Click to select which folder should appear in the Save dialog box. 

0 0 ® 0 
Off I 2 I 

optn~ or u vbJ • dool.mtnt , Ukf mt to 

Foldf.r' ...m~ oont•in• tM t9Piio•tion. lt 
0 Lut folOH" uud i'l tht .-ppHc.tUon 

0""'-"-flo!W. 
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Using the Trash Can 
Th e plump Macintosh Trash Can holds o n to items until you 
choose the Empty Trash command fro m the Special menu. 
This means you ca n rescue items you've deleted if you change 
your mind. 

To put an item in the Trash 

A plump Trash Can provides a 
visual clue that there are one 
or more items in the Trash. 

To recover an item from the Trash 

To empty the Trash 
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Using the Macintosh Guide 
The Apple Guide prompts you with step-by-step instructions for 
using System 7.5, provides visual clues such as highlighted menu 
items or circles, and checks to make sure steps are completed before 
moving on. 

To find help with a topic 

10:4SPMI?.J 
Rbout Rpple Guide 

Show Bolloons 

. , . 
Shortcuts 

PowerTollc Guide 

1 Open the? (Guide) menu and choose Macintosh Guide. 

2 Click Topics. 

4 Select a phrase. 

6 Click to go to the next step . 

You use the Monitor'$ contrOl panel to d.WJ)lay colors or 
shades: ot v-ay on your monJtor . 

The number ot colors yvu can we depends on your 
computer's vicleo capahillty(sometimesca.lled ~t 
depth} and the monitor-you're usin~. 

TobeQi"l.cld<tlleri!llta<rOW. 

'·· 

7 Click to return to the Guide window. 

more .,.. 
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Red circles 
indicate 

where to 
perlorm the 

next step. 

To use the Macintosh Guide Index 

2 Click to select an initial letter. 

3 Click an index entry. 

The Macintosh Guide displays 
help as it does with Topics. 

To use the Macintosh Guide Look For 
feature 

1 Click look For. 

2 Click the arrow, and type one or more words to search for. 

2. Oick Seuch : 

The Macintosh Guide displays 
help as it does with Topics. 

4 Click a phrase. 



Help: The Macintosh Guide, Balloon Help, Shortcuts 

Using Balloon Help 
After turning on Balloon Help, roll the mouse around and watch 
balloons appear wherever you point. In the Finder, Balloon text 
contains descriptio ns of Macintosh interface elements. 

A balloon automatically appears as you point to Desktop icons. 

To turn off Balloon Help 
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Macintosh Shortcuts 
Macintosh Shortcuts are usually keyboard equivalent commands of 
steps performed with the mouse. Keyboard equivalent commands 
usually involve a combination of keys such as ~ and an al phanu­
meric key. 

To access the online Shortcut Guide 

96 

1 Open the? (Guide) menu and choose Shortcuts. 

I 0:38 PMI:l.l 
About Apple Guide 

Show Balloons 

Moclntos h Guide 1181 

Powerlnik Guide 

o ;;;;;;;; ""'''''"""'""""''"""'''""''"''"'''""':''"""''""'"'""'"'"'""'":1!1 
Macintosh Shortcuts 

You can we keyboard commands to work quickly in the 
f inder. Click a cat~ry below. (Other keyboard 
commands are listed in the menus:.) 

le§J J irQ~n J ifJi! J 
WwiUftt wiU Workiftt wit.b W....W:.t wiUII 

i<Oftf wlnd.-s lbt wie:w 

2 Click a category button. 

To rebuild the Desktop file 

Hold down 

To tum off an system extensions when startinO up 

Hold dOwn 

~ 
whie CorY'OUttr suwts up 
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To eject floppy disk (to avokl ustno It as the 
startup disk) 

Click Topics to go back to Shortcut Categories. 

5 Click the Close box to close Shortcuts. 

Useful Shortcuts 

Action Press 

To copy an icon (instead of moving it) 
To clean up selected icons 
To clean up and sort icons 
To close all disk and folder windows 

To close a window after 
opening one of its icons 
To expand or collapse all the contents of 
selected folder in list view 
To eject a disk 
To create a new folder (in 
Save dialog boxes only) 
To rebuild the Desktop file 

To turn off all System 
extensions when starting up 
To bypass internal hard disk 
when starting up 
To skip the warning message and to 
delete locked files in the Trash 
To erase a disk automatically 
when you insert it 
To take a snapshot of the screen 
To close an application that 
has locked up 

Option-drag the icon 
Shift-Clean Up 
Option-Clean Up 
Option- cl ick any 
window's Close box 
Option-double-cl ick 
the icon 
Option-cl ick the triangle 

~-E 

~-N 

~-Option while computer 
starts up 
Shift while computer 
starts up 
~-Shill-Option-Delete 
while computer starts up 
Option-Empty Trash 

~-Option-Tab while 
inserting the disk 
~-Shift-3 

~-Option-Esc 
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Networking Computers 
Networking is built into the Macintosh operating system 
and is available on Macintosh computers that share a printer(s). 
Documents and fo lders can be sent over the same AppleTalk cable 
that connects your printer. Programs also can be linked across a 
network. A linked program can exchange document information 
with a document that resides on another Mac. 

To connect to a network 

11•1·M1f11niH' 
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rue £dll U1ew Lobel Specie! 
About This Moclntosh ... 

® RppleCD Rudlo Ployer 
CJ Rutomoted Tasks • 
1'!!1 Colculotor 

~Chooser 
!15 Control Panel• 
~Find File 
~Jig sow Puzzle 
(d Key Cops 
Cl Moil end Cotologs 
{;J Note Pod 
~Recent Rppllcotlons 
ClS:J Recent Documents 
{;8 Recent Seruers 
(l! Scropbook 
<f1 Stickles 

• Shut Down 

Apple Menu Options 
RTM'" GH 
Auto Power On/ Off 
Capture 
Color 
ColorSync'" System Profile 
Dote & Time 
Desktop Patterns 
DDS Mounter Plus'" 
[Htenslons Mnnnger 
File Shoring Monitor 
Generol Controls 
Keyboard 
lobels 
Louncher 
Moclntosh [osy Open 
Mop 
Memory 
Monllors 
Mouse 
Network 
Numbers 
PC £Hchonge 
PowerTolk Setup 

~ Network Identity 

aw ..... ..,.., ,~~~lilili 
OwMr Puswot'd :~ ~ 
~inlosh H~: 

Q File Shortng 

. 5 Type a name for your computer. 
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To mount a network volume on your 
Desktop 

Q;;J Control 
~Find File 
a'J Jigsaw Puzzle 
[;;jJ Key Caps 
CJ Mall and Catal ogs 
r.:J Note Pad 
(2) Recent Rppllcat lons • 
(ll) Recent Documents • 
(lm Recent Seruers 

You must be given access privileges to 
mount a network volume on your Desktop. 

(l!l Scrapbook 
Stickles 
• Shut Dow n 

2 Click the AppleShare icon. 

~ 

~ ~ 
lrn~g•'Writf'f LO OX Lts:trVrittr 

~ ~ 
l•ur'Wrlt•r 0)( Lutr'w'rU•r IISC 

PDO~hrGX 

5 Type your password. 

"Chris topher· as: 

Name: 

Password: 
L--'--f 

cancel ( Set Password ) 

more ..,. 
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a:: 

• 

7 Click to select a volume. 

~ Christopher 

lir:lltl 

£. 
~ 

Select the 

Checked Items ( 181 I will be opened et 
sys tem startup lime. 

Concel 

1 ro I ,f[iJi[;l1i 

:hooser 

~ IQ Select o rne server. 
Christopher 

~Vrflff'GX Sprowl 

~ 
tnqYritw lO GX lUHVrittf" 300 GX 

~ oom 
l&SKYritw GX Lu.r-VritH' USC GX 

~ ~ 
PllOHokffGX St\jlt'w'nt.r GX CEJ 

lo AppleTolk @Active 
0 Inactive 

~ 

:n 

7.41 

To use a mounted network volume 

1 Double-click the network volume icon on your Desktop. 

2 Select the documents or folders you want to share. 

Jill Mel's Shared Folder l UI 
2UtmS 3:5.1f"St'ldlsJc: 6.t r-e 

I.LI I 
~ 

~ lc 
01 
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3 Drag the documents or folders to your hard drive. 

Copy fifes/folders to your hard drive if working on the network is slow. 

To unmount a network volume 

2 Open the File menu and choose Put Away. 

I ~ llillll Edit Uiew Lobel Special \ 
New Folder MN 
Open MD 
P1inl 3&P 
Clo<e IUindow :lolW 

Get Info 3&1 
Sharing ••. 
Ouplicale ~0 

Moke Alios MM 

Find ••• MF 
Find Agoln MG 

Poge Setup ... 
Print Desktop ... 
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To give others access to files on your 
computer 

1 Open the Apple menu. 

102 

2 Choose Control Panels, Sharing Setup . 

File Edit llieuo Lobel Speciol 
About This Moclnlosh ..• 

.... 
I§ AppleCD Audio Pl ayer 
D Aulomoled Tasks • 

Col orSync- System Profile 
Dole & Time 

EJ Celculolor 
-p Chooser 
l!'!l ( ontrol Ponel\ 
11} Find File 
t!j Jigsaw Puzzle 
~Key Caps 
D Moll end Catalogs 
r;:) Nole Pad 
(2) Recent Rppllcellons 
(lSJ Recent Documents 
Iilii Recent Seruers 
Ill Scropbook 
<f' Stickles 

• Shut Down 

3 Click Start. 

Desk lop Pellems 
DDS Mounter Plus'" 
EHienslons Monoger 
File Sharing Monitor 
Generol Controls 
Keyboard 
Lobels 
Launcher 
Macintosh Eosy Open 
Mop 
Memory 
Monitors 
Mouse 
Network 
Numbers 
PC EHchonge 
PowerTelk Setup 

Sound 
Sl orlup Disk 
TeHI 
Users & Groups 
Ulews 
WlndowShede 

Shoring Setup 

c Network ldenllly 

OwhM'" H.vrw : lt~q._.a -. 
Owntt- Password: E=:=J 
.........,.....,., ,......_.c 

D File Shoring 

I 

I 

r:Sbt 
~ j f~sh.lrbjllsoff. ClidcSt.arl to •no-.t othtrUJKJ I 

to lCCifiS lhwtd fo\cSH's. 

~ Program Linking 
su.t 

~ rPr09".,.......,. fs off. CHclcSIM'tw • llowo....,. I uurs to~ to !Jour t:Nrtd prqM"M. 
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Ulliii Edll Ulew Label Special I 
New Folder 88N 
Open 880 
Print i!I:P 
Cl ose Wlndotv 'I€W 

Get Info 881 

Duplicate :1!;0 
M alee Alias 88M 
Put Away MY 

Find ..• 88F 
Fi nd Again 886 

Page Setup •.• 
Pr1n t Desktop .•• 

5 Open the File menu and choose Sharing. 

6 Click to select the Share This Item box. 

7 Click the Close box. 

s.. s.. ..... 
foiOtrs: ro.. Cllon9t< 

ov..,-: 1 ,.,., · I r8l r8l r8l 
Unr/Or ... :l <Hoot> · I r8l r8l r8l 

btrVOM r8l r8l r8l 
0 ~an CUTfflt~ tneloMd (oldtt'J tb thh: ont 

0 t,n' t b<t movl'd, r«Umf'd or dtltttd 

Saue changes t o access pr1ulleges f or 
"Mel 's Shared Folder"? 

[ Don' t saue l 
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To register new users so they can connect 
to your computer 
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® AppleCD Rudlo Plcyer 
D Rutomoted Tasks 
EJ Calculator 
~Chooser 
!:!; Control Panels 

~ Find Fil e 
~ Jigsaw Puzzle 
u=J Key Caps 
D Mall and Catalogs 

(;J Note Pad 
~Recent Applicc tions 
liD Recent Documents 
lim Recent Seruers 
~Scrapbook 

~Stickles 
• Shut Down 

Open 
Punt 
Cl ose Window 

Get I nfo 
Shoring ... 
Duplicat e 
Make Riles 
Put nway 

Find ... 
Find Again 

Page Se tup .•. 

Colorsync' " Sys tem Profile 
Date 0' Time 
Desktop Patterns 
DDS Mounter Plus'" 
EHtenslons Mcncger 
File Shoring Monitor 
General Controls 
Keyboard 
Lcbels 
Launcher 
Macintosh Easy Open 
Mcp 
Memory 
Monitors 
Mouse 
Network 
Numbers 
PC EHchDnge 
PowerTclk Setup 
Shoring Setup 
Sound 
Startup Disk 
TeHt 

i!IO 
!!lP 
i!IW 

!il l 

i!IO 
iiiM 
iiiV 

a!F 
i!IG 

Print Window ... 

5 Press Return . 
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bJ File Shor ing 

[8] Allow US4'f'" to oomtet 
[8]ATiovus:trto~p.aJ~ord 

~ Program Linking 

0 ATiov US4'f" to mk to pt"ogrlmS 

onthis~tosh 

8 Click the Close box. 

Saue changes to user Information for 
"Chr1stopher"7 

( Oon•t Soue J 
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To deny access to a user 
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@11 RppleCD Rudlo Plnyer 
CJ Rutomnted Tnsks • 
Iii! Cnlculntor 
~Chooser 
1!'5 r onh nll'dlll'h 

~Find File 
~ Jlgsnw Puzzl e 
[8 Key Cnps 
CJ Mnll nnd Cntnlogs • 
[,J Note Pnd 
~Recent Rppllcntlons 
(iD Recent Documenls 
tillJ Recent Seruers 
Ill Scrnpbook 

SUckles 
• Shut Down 

.... 
Color Sync'" Sy stem Profile 
Dnte & Time 
Deskt op Pntterns 
DOS Mounter Plus' " 
EHt enslons Mnnnger 
File Shnrlng Monitor 
Genernl Controls 
Keybonrd 
Lnbels 
Lnuncher 
Mnclntosh Eesy Open 
Mnp 
Memory 
Monitors 
Mouse 
Network 
Numbers 
PC EHt hnnge 
PowerTnlk Selup 
Shnrlng Setup 
Sound 
Stnrtup Disk 
TeHt 

2 Choose Control Panels, Users & Groups. 

~ Progrnm Linking 

0 "nov ~tttr to lW< to PI"09"~~~'~' 
onthbMKintom 

5 Click the Close box. 
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Soue chnnges to user informotion ror 
~christopher"? 

[ Don' t Soue ) 

To set access privileges 

E§l Appl eCD Audio Pl ayer 
CJ Automated Tosks ~ 

ColorSync'" System Profile 
Dole &Time 

Ill Col culolor 
~Choos er 

~Control Panel\ 
~ Find File 
~ Jlgsow Puzzle 
~Key Cops 
CJ Moil ond Cola logs ~ 

bJ Note Pod 
B9 Recent Applications ~ 

~ Recent Document s ~ 

!WJ Recent Seruer s 
(l!l Scropbook 
~Stickles 

• Shut Down 

Desktop Patterns 
DOS Mounter Plus'" 
EHtenslons Monoger 
File Shoring Moni tor 
Generol Controls 
Keyboord 
Lobels 
l auncher 
Mocintosh Eosy Open 
Mop 
Memory 
Monitors 
Mouse 
Network 
Numbers 
PC EHchonge 
PowerTolk 

Sound 
Stortup Disk 
TeNt 
Users & Groups 
Uiew s 

2 Choose Control Panels, Sharing Setup. 

Shorlno Setup 

~ Network Identity 

OwMf"rut'nfo : IH1r1i :Ji 'I 
Owrwr Pusv«d: ~ 
M~intosh H.wn. : l~tntosl'l t1> I 

LJ File Shoring 
Sbtu 

~ f'" ....,..,., Is off.CllokSt.-t to ollow •""' """ I 
to toCOtSS sh¥td foldft-s . 

~ Progrom Linking 

0§!0 r~:;-:~~ is off. Clkks;:;;7o:·;-,..~~l 
1 uUf's to link toy01.r sh.a.rt<l Pf"09"¥M. 

3 Click Start under File Sharing. 

more .,_ 
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4 Click a shared disk or folder to select it. 

l Macintosh HD ~-~ 
13 it.nu 35111W.dlsk 6 .2 t13 n .11ilablot 

~~~~A. 
0 

li> 
¢ 1911 

5 Open the File menu and choose Sharing. 

I .. lllill:. Edit Uiew label Special I 
New Folder XN 
Open xo 
l'rlnt ~p 

Close Window ili!IU 

Get Inf o X I 

Oupllcat• !!gO 
Make Alias XM 
Put Away XY 

Find ... X f 
find Again X G 

Page Setup .•• 
Pr int Desktop .•. 

6 Click to select the Share This Item box. 

on or -Select the pers 
group you're g 

privileg 
iving 

es to. 

Cl ick this column to allow the user t 0 

r. see and open !elders within this folde 

• - Mel"s Shared Fol er 

Q Yhfff : Maotnt01h HD: 

_I'V1 SNr"• this fttm lnd its oont.nh r--
s .. Sot M•l<t 
Fo~s Ftlts ChM9fs 

~Mr:l Mfl · I 181 181 181 
0r..,: I <Hont, · I 181 181 181 

(YfrVMf 181 181 181 
0 M»ct '" ourrtntlv tnelos.d fo~s lie• this rw ro C..'t ~ movtd, r~ Of" 6tlttf'4 

Click this column to 
allow the user to 
add, delete. and 
save changes. 

Click to prevent users !rom moving, 
renaming, or deleting the folder. 

Click lhis column to al low 
the user to see and open 
files within this folder. 
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To check your access privileges 

1 Click to select a shared item. 

2 Open the File menu and choose Sharing. 

This line shows your 
access privileges. 

I oi IIIJg Edit Uiew label Special 1 
New folder X N 
Open X D 
Pri nt X P 
Close Window !!IIW 

Get I nfo X I 

Duplica te 1180 
Make Alias *IM 
Pu t Away *IY 

Find ..• !!llf 
Find Rgaln *IG 

Page Setup •.• 
Print Oesktoo .•• 

S.t roldKs, S.. rnu, Mtkt 

s.. S.• 
Fo'dtn Fl\ts 

OYn..- : IMtt 1!81 !81 
Unr/GrMp : !81 !81 

Evtr\IOM !81 
0 Hah .all CUTtnt"" .no loud foldtr's 11:t ts ... 

Xs indicate see, open, 
and copy access. 

Xs indicate see, 
open, copy, delete, 
add, and change 
access. 
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To change your password as a re gistered 
user 

1 Click to select a volume on which you are a registered user. 

2 Open the Apple menu and choose Chooser. 

liill File £dll Uiew Lobel Special 1 

About This Moclntosh •.. 

19 RppleCD Audio PI oyer 

D Rutomoted Tosks ~ 

8 Colculotor 

'' 
G:;£) Cont rol Panels J 
~ Find File 
~ Jigsaw Puzzl e 

Ia Key Cops 
D Moil and Cotol ogs ~ 

bJ Note Pod 
~Recent Rppllcotlons ~ 

(lD Recent Documents ~ 

(5;] Recent Seruers 
Ill Scrapbook 

~Stickles 
iJ • Shut Down 

3 Click the AppleShare icon to select it. 

~ ~ 
lrM9t"''ntH" LQ OX L.s.rVrttH" 300 OX 

~ ~ 
l •strVr itf'r OX Lu.,-Vrittt" IISC GX 
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Alrendy connected to the file seruer "Mnry 
Jo's Computer" ns: 

QGuc•t 
® Registered User 

Nnme: Mnry Jo 

( cnncel 

8 Type your old password. 

~ 
~ 

9 Type you 

Old pnssword: L••• J 
New password: I ••••~ 

( Cancel ) ll OK Jl -

li( I."ITil~l I 

Plense reenter your new pnssword for 
confirmation. 

r new password. 

more ..,. 
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14 Click to select a new volume. 

~ Mory Jo's Computer 

Select the Items you wont to use: 

1:-toclnto•h uo DC 
Checked Items ( 181 l will be opened ot 
system startup time. 

concel II oK 11 
.l •3.5 

15 Click OK to access a volume previously selected. 

To change your password as a computer 
owner 
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~ RppleCO Audio Player 
D Automated Tosks ~ 

l3 Colculotor 
%Chooser 

~Find File 
[B Jigs ow Puzzl e 
[d Key Cops 
D Moil ond Cotologs 
~Note Pod 
l2J Recent Rppllcotlons 
!hJ Recent Documents 
lila Recent seruers 
Ill Scropbook 

Stickles 
• Shut Down 

Auto Power On/ Off 
Capture 
Color 
ColorSync'" System Profile 
Dote & Time 
Desktop Po Items 
DOS Mounter Plus~ 
[Htenslons Monoger 
File Shoring Monitor 
Genen1f Con1rols 
Keyboard 
labels 
Launcher 
Macintosh £osy Open 
Mop 
Memory 
Monitors 
Mouse 
Network 



Networking: Connect, Register, Privileges, Passwords, linking 

4 Press Return. 

s Click the Close box. 

To restrict access to a shared item 

1 Click a shared folder or disk to select il. 

2 Open the File menu and choose Sharing. 

I • lllmi Edlt Ule11• Lebel Speclel I 
New Folder illlN 
Open IIIlO 
Print 31lP 
Clo•c Window illlW 

Get Info IIIl i 

DUilllcote llflD 
Meke Alles illlM 
Put Awey II€Y 

rind ... illlr 
Find Agoln IlliG 

Pege Setup •.• 
Print Desktop ••. 

more ... 
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3 Click boxes so only boxes next to the owner have Xs. 

4 Click the Close box. 

Macintosh HD 

Saue changes to access prlulleges for 
" Macintosh HO"? 

( Don't Saue I ( Cancel I I Saue .. 1 

.. ..._, 

To stop sharing an item 
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2 Open the File menu and choose Sharing. 

l -~Edit Ul w Lebel Specie! J 
New Folder 38N 
Open 380 
Print !liP 
Close Windo llf!UJ 

Get Info 38 1 

Oupliro t e :.1;0 
Moke Alios 38M 
Put Awoy 38Y 

Find ... 38F 
Find Ageln 386 

Pege Setup ••• 
Print Oesktop ••• 

3 Click the box to remove the X. 

I HO 

1-=~ 
.~ .. its conttnts 

s.. ... l"lah 
F'o~rs F'M-s ""-· Ovn•r : I 

-· .» 
~I ~ (8! l8i 

Usrr/Graup : I <'fi>.v~• ~ ) 0 0 0 
E'lft'VOIW 0 0 0 

Saue chonges to occess prluileges for 
"Macintosh HO"'? 

[ Oon't Soue I [ Cancel I 1\. Soue ~ 
-r--

5 Click Save. 
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To turn off file sharing 

' ' "·IJ.I''fllnW'11 

~~F=IIe~E~dl_t_U~Ic-w-~Lo~be~I ~S~pe-c~lo~l 
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8 ApplcCO Audio Pl oyer 
CJ Automoted Tosks ~ 

13 Colculotor 
~Chooser 
!!; (on h oi PtmPI\ 

~Find File 
~ Jigs ow Puzzle 
Gil Key Cops 
CJ Moll and Cat al ogs 
b::J Note Pod 
(£;)Recent Appllcolions 
(lD Recent Documents 

!l!IJ Recent Seruers 
~ Scropbook 
~Stickles 

• Shut Down 

Apple Menu Options 
RTM~ 6H 
Auto Power On/ orr 
Copture 
Col or 
Col orSync'" System Prome 
Oa t~ & Time 
Deskt op Patterns 
DDS Mounter Plus'" 
(Htenslons Monoger 
File Shoring Monitor 
Generol Control s 
Keyboord 
Lobel s 
Lnuncher 
Moclnt osh Eosy Open 
Mop 
Memory 
Monitors 
Mouse 
Network 
Numbers 
PC EHchonge 
PowerTolk Setup 

Sound 

2 Choose Control Panels, Sharing Setup. 

B Sharln Setup 

Bl Network Identity 

O....n.r Namt: ~~M~M~y~Jo~;========:::J 
OwnH' PUNOt'd : I····· 
Htcintorh NatM: I Mary Jo's. C0t1'19Uttr 

4 Enter the number of minutes until turn off. 

Cancel 



Networking: Connect, Register, Privileges, Passwords, Linking 

OwnwH~: 

OwntrP•ss'WOr'd :~ 
MKYitosh NMM: F.IH:=.,.=,=:Jo:==.=, c..,...;::=::=,,..:---------, 

Q file Shoring 

r::S tatu ~ 
rr::::::::::i'" 1 F'n. shM"T.9 Yill hrn off n 3 mn..tts. Click Cwtl 
~ l!,o lfoavtiton. _ 

To see who's sharing your disks or to 
disconnect a user 

@ij AppieCO Audio Pioyer 
CJ Automoted Tosks • 
l!l Coi culotor 

~Chooser 
~ Conhol PanPI\ 

1! find file 
a3 Jigsaw Puzzle 
~Key Cops 
CJ Moll and Co t o logs 
[,J Not e Pod 
@] Recent Appllcotions 

~Recent Document s 
fill! Recent Seruers 
~ Scropbook 
($' Stickles 

• Shut Down 

Menu Options 
RTM'" GH 
Auto Power On/ Off 
Copture 
Col or 
ColorSync~ System Profile 
Dote & Time 
Desktop Potterns 
DOS Mounter Plus'" 
EHtenslons Mon 

Generol Control s 
Keyboord 
Lobels 
Launcher 
Macintosh Eosy Open 
Mop 
Memory 
Monitors 
Mouse 
Network 
Numbers 
PC EHchonge 
Powerlolk Setup 
Shoring Setup 
Sound 

2 Choose Control Panels, File Sharing Monitor. 

- - -H+-Area listing 
users. 

File Shoring Actiuity: 

more .,. 
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5 Enter the number ol minutes until disconnect. 

How many min tes until selected 
users ore disco nected7 

l:Ow" ~~ 

I Cancel l II OK to.ll 

·~HITi!~l 1:• 

To turn on guest access 
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~ AppleCO Audio Player 
CJ Automated Tasks ~ 

Iii Calculator 
~Chooser 
~ ( ou ll ul l'.tn l•l\ • 

ltll find file 
~ Jigsaw Puzzle 
~Key Cops 
CJ Moll and Catalogs 
r.:J Note Pod 
@] Recent Applications 
(JD Recent Documents 
~Recent Seruers 
IE Scrapbook 

Stickles 
• Shut Down 

... 
ColorSync'" System Profile 
Dote & Time 
Desktop Patterns 
DOS Mounter Plus'" 
EHtenslons Manager 
file Shoring Monitor 
General Controls 
Keyboard 
labels 
launcher 
Macintosh Easy Open 
Mop 
Memory 
Monitors 
Mouse 
Network 
Numbers 
PC EHthonge 
PowerTolk Setup 
Shoring Setup 
Sound 
Startup Olsk 
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~ Progrom Linking 

0 Allo'W' gutsts to link to proiJ!r~ms 
on th\s M•eintosh 

To turn Program Linking on 

® Appl eCO Audio Ployer 
CJ Automated Tosks ~ 

8 Colcul otor 
~Chooser 

I!!!! (ontrol Panels 
~ find f ile 
~ Jlgsow Puzzle 
(jjJ Key Cops 
CJ M oll ond Cotologs ~ 

&:J Note Pod 
~ Recent Appllcotlons ~ 

~ Recent Documents ~ 

lim Recent Seruer s 
Scr opbook 
Stickles 
• Shut Down 

ColorSync'" System Profile 
Dote & Time 
Deskt op Potterns 
DOS M ounter Plus'" 
EHtenslons Manager 
File Shoring Monitor 
Generol Controls 
Keyboord 
Labels 
Launcher 
Macintosh Easy Open 
Mop 
Memory 
Monitors 
Mouse 
Network 
Numbers 
PC EHchonge 
PowerTolk Set 

Sound 
Stortup Disk 
TeHt 
Users & Groups 
Ulews 

2 Choose Control Panels, Sharing Setup. 

4 Click the Close box. 

• ~ y.,.=:;=;:al 

St•tus•--:--c-:::-:--:c--:--::----, 
rProqr~m lririno;l is off. Click Sttrt to • How ottwr 
I ~'""' to lri:: to '!lOll" shan-d progt"".tmJ . 
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To turn Program Linking off 

• 1 I I • 

File Edit Uiew Lobel Special 
About This Macintosh ... 

If]) Apple CO Audio Player 
CJ Automated Tesks ~ 

fa Calculator 
~Chooser 

!I! l nnh oll'cHH'I \ ~ 

~Find File 
as Jigsaw Puzzle 
Gj] Key Cops 
CJ Moll and Colo logs ~ 

(;J Note Pod 
~Recent Applications ~ 

(]l] Recent Documents ~ 

lim Recent Seruers 
Ill Scrapbook 
~Stickles 

• Shut Down 

Colorsync'" System Profile 
Dele & Time 
Desktop Patterns 
DOS Mounter Plus' .. 
EHienslons Moneger 
File Sherlng Monitor 
General Controls 
Keyboard 
labels 
leuncher 
Macintosh Easy Open 
Mop 
Memory 
Monitors 
Mouse 
Network 
Numbers 
PC EHchonge 
PowerTolk Setup 

Sound 
Startup Disk 
TeHI 
Users & Groups 
Ulews 
WlndowShode 

2 Choose Control Panels, Sharing Setup. 

4 Click the Close box. 
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Printing: Fonts, QuickDraw GX, Portable Digital Documents 

Fonts 
QuickDraw GX supports TrueType and includes a new version of 
Adobe Type Manager (ATM GX) which means System 7.5 users can 
continue to use the fonts they have used with previous versions of 
the System. As with the previous version of ATM, you can turn 
ATM GX on or off, as well as adjust (reduce) the size of the font 
cache to make room for running applicatons. 

To install a font 

1 Quit all application programs. 

3 locate the font(s) you want to install. 

Pu t these fonts Into the Fonts fo l 
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Printing: Fonts, QuickDraw GX, Portable Digital Documents 

To remove a font 

1 Quit all application programs. 

2 Open the System Folder. 

~MI!!I sustem Folder Sill[ 
12\ttms 82N8 in dfsk 174 .1 MB 

<() 

ll~t 
{). 

¢ 1 ~ill 

3 Double-click the Fonts folder. 

To turn ATM GX on or off and set the font 
cache 
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(§ Appl eCO Audio Player 

D Automated Tas~s ~ 

m Col culator 
~Chooser 

l!!!i Control Panels ~ 

~ Find File 
~ Jlgsnw Puzzle 

tiiJ Key Cops 
CJ Moll and Colologs 
()Not e Pod 
@] Recent Applicolions ~ 

~ Recent Documents ~ 

rim Recent Seruers 
119 Scrnpboo~ 

Stickles 
• Shut Down 

ower 
Coplur e 
Color 
ColorSync' " System Profile 
Dale & Time 
Des~top Pollerns 
DOS Mounter Plus'" 
EHienslons Manager 
File Sharing Monilor 
General Controls 
Keyboord 
Labels 
launcher 
Moclnt osh Easy Open 
Mop 
Memory 
Monitors 
Mouse 
Nelwor~ 

Numbers 
PC EHchonge 
PowerTo l~ Setup 
Shoring Setup 
Sound 
.... 



Printing: Fonts, QuickDraw GX, Portable Digital Documents 

3 Click On or Off to enable/disable. 

Adobe Type ManagerT" 

Prtsttr•n 

@ Lwsp .. in<j 

0 Clur.tcttf' Jh~ 

To f ind out which fonts are installed 

1 Open the Apple menu and choose Key Caps. 

liill File Edit Uiew Lebel 
About This Macintosh .•. 

@iJ AppleCD Audio PI eyer 
CJ Automated Tasks 
Iii Calculator 
~Chooser 
G;;) Control Panels 
~ Find File 
~Jig sew Puzzle 

CJ Moll and Cetel ogs 
b::J Note Pod 
@J Recent Appllcetions 
(lD Recent Documents 
lim Recent Seruer s 
Ill screpbook 
~ Stick les 
Iii • Shut Down 

The menu lists the fonts 
installed on your System. 

Chicego 
Courier 
Geneu" 
Heluetlca 
Hoefler TeHt 

• 
• 
~ 

• • 

Speciel l 

Hoefler TeHt Ornaments 
Monnco 
New York 
Palatlno 
Skl10 
Symbol 
Tek ton Plus Regular 
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Printing: Fonts, QuickDraw GX, Portable Digital Documents 

Printing 
Create o ne or more Desktop printer icons to represent the p rinters 
you use. To print one or more documents, drag and drop the docu­
men ts on a prin ter icon. 

To print a document 

Printer " LoserWri ter II NT" 

Copies: Q Pages:@ Ail 

Couer Page: @No 0 First Poge 0 Last Poge 

Paper Source: @ Paper Cassette 0 Manual Feed 

Destination: @ Print er 0 Disk File 

Print Pages: @ Ail 0 Odd Pages Only 0 Euen Pages Only 

Section Range: From: I To: I 0 Pr int Selet lion Only 

0 Pr int Hidden TeHI 0 Pnnt NeHI File 0 Print Dock To Front 

To switch printers or create a new Desktop 
printer icon 

1 Open the Apple menu and choose Chooser. 

1111 File Edit Uoew Label Specla~ 
About This Macintosh ••• 

(§ RppleCO Audio Ployer 
Cl Automated Tasks 
j" Cal cul ator • 

II; 
[1--

Qi) Cont r ol Panels • ~Find File 
~Jigsaw Puzzle 
~ Key Cops 
Cl Mail ond Catalogs • b:J Note Pad 
@£) Recent Applications • (A] Recent Documents • {i;) Recent Seruers 
~ Scrapbook 

~Stickles 
i • Shut Down 

1211 



Printing: Fonts, QuickDraw GX, Portable Digital Documents 

2 Click the type of printer you want to use. 

~ 
~'w'rftH' LO OX luff"'w'r itf't" 300 

~ 

POO M;a~tt" GX 

4 Click to select an icon representing a port. 

Instead of a port, you can click a printer name if you 
are connected to an Apple Talk network. 

5 Click Create to make a Desktop printer icon. 

6 Click the Close box. 

7 Arrange your Desktop printer icons in a convenient location. 

With OuickDraw GX installed, background printing is automatically avai lable. 

To check on the print status of one or more 
documents 

Alternatively, 
you can print 

from within your 
application. 

more._ 
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Printing: Fonts, QuickDraw GX, Portable Digital Documents 

Printer " l oserWrlte r II NT" H~ , II Print .. 11 
Copies: [C Pdges: ®All 0 From: D To: D ~ ~ 
Couer Page: ®No 0 First Poge 0 Lost Poge 

Paper Source:@ Paper Cdssette 0 Monual Feed 

Oesllnollon: ® Print er 0 Disk rue 

Print Pnges: @All 0 Odd Poges Only 0 [uen Poges Only 

Sec tion Rnnge: From: I To: I 0 Prmt Selett ion Only 

0 Print Hidden TeHt 0 Print Neut File 0 Print Bnck To Front 

2 Cl ick Print in the application's Print dialog box. 

J I •I®!'I!A3!ro®jj,jijoi!lo!IJI!j,j,i 

.L 

IDID Doe~nts In ()IIHw : 7 
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Printing: Fonts, QuickDraw GX, Portable Digital Documents 

To halt printing 

1 Select one or more documents. 

[01] Ooot.rntnts in Ouf.ut: 4 

1 Normal 

l tdn d(prYit) l 1 Uormal 

165Miik$AU8UII 1 NorrNl 

To resume printing 

lt!IT'il:l't~'1111 1 l'lll 

LoserWrlter II NT 

~~) [ Remove l I Oooet.m.nts ... C)utou. : 4 

OowmtntN¥M P~s CopWs etl!JlliD1 

{j 
Ltaf .blut(prW\t) I 1 Norm• I 

us.,. t-t.l;documtnt Lt<~f b~1nt); s tatltS: prtpwtlq dab 

~ luf.'Tt.n{print) 1 1 Normal 0 

~ luf .r'td{9f"int)l 1 1 Normal 

• ID'F"II~-~~~~~~ 1 I """' 0 
:;II ·~ Iii 
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Printing: Fonts, OuickDraw GX, Portable Digital Documents 

To delete one or more documents from the 
print queue 

1 Select one or more documents to delete. 

I OocUI"ffottttS in QuN. : 4 

Ooeum+nt N¥M 

lufnd(print)l 

lBiiiilil:t!:mid&lil 

To batch-print a number of documents 
created with the same application 

Large numbers of 
documents can be left 

unattended to print 
for several hours if 
the documents are 

created with the same 
application. 
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Printing: Fonts, QuickDraw GX, Portable Digital Documents 

3 Click OK in the application's Print dialog box. 

Printer "LaserWrlter II NT" 1 .o ~ 

Copies: C Pages: ®All 0 From: D To: D 1 cnncel ) 

Couer Page: ®No 0 first Page 0 Last Page 

Paper Source:® Paper Cassette 0 Manual feed 

Destination: ®Printer 0 Disk File 

Print Poges: ®All 0 Odd Pnges Only 

Section Rnnge: From: 1 To: I 

0 Print Hidden TeHt 0 Print Neut file 

0 Euen Poges Only 

0 Print Selection Only 

0 Pr int Bock To front 

Portable Digital Documents 
Portable d igital documents (PODs) reduce paper and save the time 
required to print. PODs can be opened, browsed, and printed with­
out the application used to create them. 

To create a portable digital document 

1 Open the Apple menu and choose Chooser. 

mrne [dlt Uiew Lobel Special] 
About This Mocln tosh •.. 

t!ij Appl eCD Audio Playor 
D Automated Tosks ~ 

EJ Calculotor 
00 

Gm Control Panels "t ~ 

~ find file 
tB Jigsow Puzzl e 
Gil Key Cops 
D Moll ond Cotologs ~ 

r.J Note Pad 
~Recent Rppllcotlons ~ 

ClD Recent Docum ents ~ 

tim Recent Seruers 
Ill Scropbook 
<f1 Stickles 
111 • Shut Down 

2 Click POD Maker GX. 

3 Click Create to make a Desktop printer icon. 

~ 
LQ GX lutr'W'ritf'f' 300 OX 

~ 
lu.-r'tt'dtt'f" IISC OX 

0 

Sty\t'tlfrittf" GX 

®Active 
0 AppieTalk 0 lnacUve 

7.41 I 

4 Click the Close box to close the Chooser. 
more ... 
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Printing: Fonts, QuickDraw GX, Portable Digital Documents 

130 

Printer " POD Maker GH" 19 

Copies: [g Pages: @ All O From: c:::::Jlo:c:::::J 

Couer Page: ®No 0 First Page 0 last Page 

Print Pages: ®All 0 Odd Pages Only 0 Euen Pages Only 

Section Range: From: I To: I 0 Print Sel ection Only 

0 Print Hidden TeHt 0 Print Ne11t File 

Desktop ) 

New LJ ) 



Printing: Fonts, QuickDraw GX, Portable Digital Documents 

To view a portable digital document 

1---------fS severe, was the most frequently reported s1de 
trials, \Yith an incidence rate not 

ijij~ij~iijijif from placebo. 

re:scribed ZANTAC, the o/o r educoon in 24-hour 
1--------f with a 92% reduction in nocturnal acid 

mg b.i.d. significantly reduces daytime , nighttime: and 
acid contact time. 

3 Choose Next Page or Previous Page. 

To print a portable digital document 

wllllill Edit Font Size style Sound 

~ New II€N Scrtpt.PDD 
Open .•. 11€0 

Cl ose 11€W 
Soue 11€5 
Soue As ... 

sometimes severe, was the most frequently reported s1de 

Poge Setup •.• ntrolled clinical trials, with an incidence rate not 
ly different from placebo. 

Print OnE opy 
a.rt 2 

Quit II€Q 
who are prescribed ZANTAC, the % reduction in 2+hour 

ion is 63% with a 92% reduction in nocturnal acid 
se retion. 

Pa. eS,Chart 
2/. ~TAC 150 mg b.i.d. significantly reduces daytime, nighttirr.e and 
24 hour esophageal acid contact time. 

1 Open the File menu and choose Print. 

3:35PM 

i 
~ 

more ..,. 
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Printing: Fonts, QuickDraw GX, Portable Digital Documents 

2 Open the pop-up menu. 

I.O .Ifl o3 

Pages: ~iT=-'-'~=~ 
0 From: I I To: Ll - ---l 

Caples: !liiiill 
[ More Choices ) 
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Security: Protect Files, Disks, System, Disk First Aid 

Protecting Files, Disks, and 
Folders 
A locked disk, file, or folder means items cannot be changed or 
deleted. "Locking" the System or Applications Folder means the 
folders can be opened, but items cannot be removed . 

To protect a file or disk 

2 Open the File menu and choose Get Info . 

I .; IIIIJlll Edit Uiew Lebel Specleli 
New Folder X N 
Open xo 
Polo I 31lP 
Cl ose Window ~w 

Sherlng ... 
Oupllcel e xo 
Meke Alles X M 
Put Awey XY 

Find ... !U 
Find Ageln 1116 

Pege Setup ... 
Print Desktop ... 

kt.a4 : SI.tpM'P•Witdoe~t 
Stu : 141( on cttsk (9,434 ~tts u .. d) 

VliH"• : ~W\tosht() : 

Cr••t.-41 :SIM\ • .An 26, 19'94, 2 :-49 PH 
:~.~26. 1,..,2:'49PM 

:nl• 

133 



Security: Protect Files, Disks, System, Disk First Aid 

To protect the System and Applications 
Folders 
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"r"•':: ose Control Panels, General Controls. 

File Edit Uiew label Special 
About This Macintosh ... 

e!j AppleCD Audio Player 

CJ Automated Tosks • 
E1 Calculator 

~Chooser 

l!l!! [ ontrol Panel• 
~ Find File 
~ Jigsaw Puzzle 
WJ Key Cops 
D Mall and Cat alogs 
r;:J Note Pod 
@) Recent Applications 
(iS] Recent Documents 
!ill Recent Seruers 

Ill Scrapbook 
~ Stickles 
I • Shut Down 

3 Click Protect System Folder . 

Apple Menu Options 
ATM'" GH 
Auto Power On/ Off 
Capture 
Col or 
Col orSync'" System Profile 
Dote fr Time 
Desk top Patterns 
DOS Mounter Plus '" 
EHtensions Manager 
File Shoring Monitor 

Keyboard 
l abels 
launcher 
Mocintosh Ensy Open 
Mop 
Memory 
Monitors 
Mouse 
Networ k 
Numbers 
PC EHchonge 
PowerTolk Setup 
Shoring Setup 
Sound ... 

• General Control s 

- Duttop - lns:.r tion Point Oliftlcint -

[8] Show Otslctop whtn In b¥:k9f"OI.M 1:1 .:O. k 0 ® 0 
Slow f u t 

[81 sho.., l a-uoohff ~~ svst.m st.,-tup • r- Hf'nu Blinldnt 

II I Shut Oov• v~rn in9 

. 
0 0 ® 0 

I Off I 2 3 
_ [8J IW'&rn nw if c~ttf" wu shut down i"rvOO*r)J 

r- Fold....- Prot..etio• r- Doc umPnts 

..... ~ Prottoet ~d.m Foldtr ~ 
~ op«~Wj M' nv~ .a docWMnt , b kt mt to 

0 fold• r 'IIIMch c«~bins tM ~plic.aHon . 

~ Prott-et AppUca\ions foldtr ~ 
@ l .st foldtr os+d in tht • pplkaHon . 

r- QDo<:...,....nts foldf'!'" . 

a Lflllil:tlil o!Glil •. ' I ol llif.liTITil.:'lll:fi'lro ·:r. 



Security: Protect Files, Disks, System , Disk First Aid 

Testing and Repairing Disks 
Apple's Disk First Aid Utility repairs defects in the directory of a 
Macintosh disk. Apple describes the program as a "first step" in the 
repair of any defects and recommends specialized disk utility soft­
ware if the disk is severely damaged. After the directory is repaired, 
the disk's Desktop must be rebuilt to notify the Mac of the changes 
in the disk's directory. 

To test and repair a disk with Disk First Aid 

When the window is 
selected, the Close 

box appears at the left 
end of the title bar. 

4 Close the Disk Tools window by clicking the Close box. 

rind ... K F 
Find Rgoln KG 

7 II the problem disk is a floppy disk, insert it in the floppy drive. 

more ~ 
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Security: Protect Files, Disks, System, Disk First Aid 

8 Double-click the Disk First Aid icon. 

7 ittms 

9 Click to select the problem disk. 

Disk First Aid 
S.!,t.et vokrnt(s) VH'lf~ : ~ofvobntsuJ.ct.d : I 

~~ 1'53 
c:::J ~ 

WWJIIMljffi MKintoshHO MKintoshtiO 
~ttt'nll 

~ 
CtcM Ortvtr Y2.1 1 SCSIIO 0 (• ) 

(Stwtup Disk) 

¢1 
Rnlf'v Ntructions ..-.d r t sults: 
Disk Ftrs t Aid : ~ r ~~[ Uertry ~ OiJ< r trst Aid is • utilit\1 wtnch vtrifits tht dirtctor\j struohr t of~ 
H-.r.,.cht~l f1~ ~sttm (i-FS) butd st0r'"9t vo)Jmt . M.nv h.rd Clute dr'tVts , 

[ Repair ) I~ ctid:: M'ld ~.a~ t Oiik-(CO), tvts .,., txwrc>lts o0 4'S·b•nd s tor• 
vol~s . 

[ ~top ) 1r wnp•f'"f.cbons .,., f~ vtthln • oluriw Oble frst Aid C¥1 0. us.d u • 
• tW'st sttp• to r.-p• r tht 6tfKts I YO \JIM hU sufftrtod stYtn OOf'"niP\IOn 

othtt" ut1hty PI"'09f"MnS or r~1r'"' thods m ty I'IHd to 1M' u:1t11 

Ru•nlng Dlst rlnt Aid : 

Ch(.k on tM vobrw ~ou wouU 1*• v.rtf\j or rf'S).IIir' . Hultil" vobnH un 
tt. st ltct.-ct by h0ldlfll9 6ovn tht St\1 IICtv whilt cl~~ on lM ..-o\.mts . 6 

10 Click to verify the disk's directory. 

11 Click to repair the selected disk. 

To rebuild your Desktop 
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1 Hold down the )::( and Option keys. 

nre you sure you went to rebuild the 
desktop file on the disk " Macintosh HD"? 
Comments In info windows w ill be l ost . 



Sound: Volume, BeeP., 

Controlling Sound 
Macintosh computers come with alert sounds in stalled in the 
System. The Sound control panel allows you to select from six 
preinstalled alert sounds and to control the volume of the comput­
er's internal speaker. 

1 Open the Apple menu. 

2 Choose Control Panels, Sound. 

File Edit Uiew Lebel Special 
About This Macintosh ••. 

@3 AppleCD Audio Player 
D Automated Tasks ~ 

Iii Calculator 
~Chooser 
!1!1 Control Panel< 
1} Find file 
~ Jigsaw Puzzle 
Ia Key Cops 
D M oll and Co t o logs 
r.J Note Pod 
~Recent Applications 
(lD Recent Documents 
lim Recent Seruers 
G'!l Scropbook 
<fl Stickles 

• Shut Down 

Apple Menu Options 
ATM'" GH 
Auto Power On/ Orr 
Capture 
Color 
ColorSync'" System Pro le 
Oote II' Time 
Desktop Patterns 
DOS Mounter Plus'" 
EHtenslons Manager 
File Shoring Monitor 
General Controls 
Keyboard 
Lebel$ 
Launcher 
Moclntosh Eosy Open 
Mop 
Memory 
Monitors 
Mouse 
Network 
Numbers 
PC EHthonge 
PowerTolk Setup 
Shoring Setup 

3 Drag the slider to adjust the volume. 

Alert Uolume ~ 

6 Click the Close box. 
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Sound: Volume, Beep, Install, Remove, Record, Audio COs 

Installing and Removing 
Sounds 
Sounds native to the Macintosh operating system are called sound 
resources or System 7 sounds. Those that are installed in the System 
act as alert sounds. 

To install a sound 

Sounds need to be stored In the System 
file In order to be BUelleble to the 
Macintosh. Put "Good Morning" Into the 
System flle7 

To remove a sound 

2 Drag the sound you want to remove out of the System file. 
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Recording Sound 
To record sound, a Macintosh needs a microphone. If your Mac 
didn' t come with a microphone, you need to buy a product like 
MacRecorder from Macromedia. 

Menu 
ATM'" 6H 
Auto Power On/ Off 
Capture 
Color 
ColorSync'" System Profile 
Dale II' Time 
Desktop Patterns 
DOS Mounter Plus' " 
EHtenslons Manager 
file Sharing Monitor 
General Controls 

• Keyboard 
Labels 
Launcher 
Macintosh Easy Open 

' 
2 Choose Control Panels, Sound. 

,......1 fllut Sound• 

] 

Mouse 
Network 
Numbers 
PC EHchange 
PowerTalk Setup 

Sound 

Droplet 
Indigo 
Quack 
Simple INP 
Sotuml 
Wild E•p 

Setu 

Rl ert Uolume T 
I 

3 Click the Add button . 

4 Cick Record to begin recording. 

a Type a name. 
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Sound: Volume, Beep, Install, Remove, Record, Audio COs 

Using the Apple Audio CD 
Player 
Apple's CD-ROM d rive can play audio COs in the background while 
you work on your Macintosh. The AppleCD Audio Player is a desk 
accessory, so it can be opened at any time-even when you have 
o ther software running. 
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1 Insert an audio CD in the CD-ROM drive. 

2 Open the Apple menu. 

Calculat or 

~Chooser 
Qi;) Control Panels • 
. find File 
~ Jigsaw Puzzle 
Gil Key Cops 
CJ Moll end Catalogs 
(;J Note Pod 
(2] Recent Rppllcellons 
(iD Recent Documents 
~ Recent Seruers 

Scrapbook 
Stickl es 
• Shut Down 

4 Click Play. 



Index 

A 
access code prompt, 69 
access privileges (networks) 

checking, 109 
denying, 106 
setting, 107-108 

alert sounds, 13 7 
aliases, 82-83 
appending 

Apple menu, 22 
Launcher items, 89 
Scrapbook, 36-37 

Apple Guide menu, 2 
Apple menu, 2 

appending, 22 
removing items, 22 
submenus, 23 

AppleCD Audio Player, 140 
AppleTalk Catalog, 

opening, 71 
Application menu, 2 
applications 

memory size, 87 
opening, 83,85, 88 
preventing switchout, 

86 
switching, 88 

Applications folder, 
protecting, 134 

ATM GX, 121-122 
attachments (e-mail), 72-74 

B 
Balloon Help, 95 
batch printing, 128 
bringing windows to 

front, 8 

c 
caches, see disk caches 
Calculator, 46 
capturing windows, 13-14 
CD player, see AppleCD 

Audio Player 
CD-ROM discs, 64 
cleaning up windows, 11-12 
Clipboard, checking 

contents of, 39 
closing windows, 7 
collecting e-mail, 78 
color 

Desktop, 17 
labels, 18 
monitor adjustments, 

21 
text highlights, 16 
windows, 16 

commands 
Apple menu (Find File), 

84 
Edit menu 

Copy, 19 
Create Publisher, 40 
Paste, 20 
Subscribe To, 41 

File menu 
New User, 104 
Put Away, 64 
Sharing, 103 

control panels 
installing, 31 
removing, 32 

Copy command (Edit 
menu), 19 

copying 
data, 34 
icons, 5 
Scrapbook items to 

documents, 38-39 



Index 

Create Publisher command 
(Edit menu), 40 

cutting data, 35 

D 
da te, 25-28 

formatting, 25 
Daylight Saving Time 

option, 27 
deleting 

jobs fro m print queue, 
128 

Note Pad, 52 
PowerTalk key chain 

record, 68 
system extensions, 30 

denying user access (net­
works), 106 

Desktop, 2 
colo r, 17 
network volumes, 

98-101 
rebuilding, 136 

disconnecting users, 11 7 
discs, see CD-ROM discs 
disk caches, 57 
Disk First Aid, 134-136 
disks, see individual disk 

types 
DOS fil es, 43-45 
drag-selecting icons, 3 

E 
e-mail 

attachments, 72-74 
collecting, 78 
enclosures, 79-80 
mailbox 

names, 81 
preferences, 77 

peer-to-peer, 65 
quitting, 76 
saving, 75 
sending, 75-76 
service changes, 70 
turning on/off, 69 

Easy Open, 43-45 
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Edit menu commands 
Copy, 19 
Create Publ isher, 40 
Paste, 20 
Subscribe To, 41 

e jecting 
CD-ROM d iscs, 64 
floppy disks, 63 

emptyi ng Trash Can, 92 
enclosures (e-mail), 79-80 
erasing fl oppy disks, 63 
expanding windows, 14 
extensions, 28-29 

F 

deleting, 30 
saving, 30-31 
turning o n/off, 30 

File menu commands 
New User, 104 
Put Away, 64 
Sharing, 103 

File Sharing Monitor, 117 
fil es 

aliases, 82-83 
colo r, 18 
DOS/Windows exten-

sions, 44 
Easy Open, 43-45 
folders, 90 
PC Exchange, 43-45 
protecting, 133 
sharing setup, 102-103 
Trash Can , 92 
turning off sharing, 116 

Find File command (Apple 
menu), 84 

finding installed fonts, 123 
floppy disks, 62 

ejecting, 63 
erasing, 63 
formatting, 62 

folders, 90 
color, 18 
naming, 90-91 
protecting, 133 



fonts 
ATM GX, 121-122 
finding, 123 
installing, 121 

ote Pad, 49-50 
rem oving, 122 

fo rmatting d isks, 62 

G 
graphics 

copying, 34 
cutting, 35 
pasting, 34-35 
puzzle, 54 

grayscale (monitors), 21 
guest access (networks), 

118-119 

H 
h ard disks 

caches, 57 
startup d isks, 58 
virtual memo ry, 59 

Help 
Balloon Help, 95 
Index, 94 
keyboard sho rtcu ts, 

96-97 
Topics, 93 

h id ing 
Launcher, 90 
windows, 9 

ho lding print jobs, 127 

I 
icons 

aliases, 82-83 
color, 18 
copying, 5 
getting info, 6 
moving, 5 
naming, 4 
new, 19-20 
opening, 4 
PC disk icon, 62 
selecting, 3 
viewing, 12 

Index 

Index (Macintosh Guide) 
94 I 

In its, see System extensions 
install ing 

control panels, 31 
fonts, 121 
sounds, 138 

J-K 
Jigsaw Puzzle, 53-56 

Key Caps, 47-48 
keyboard 

L 

control settings, 24 
shortcuts, 96-97 

labels (colo r), 18 
Launcher 

appending items, 89 
hiding, 90 
o pening applications or 

documents, 88 
removi ng items, 89 
showing, 90 

linking, p rogram, 119-120 
locking 

d isks, 133 
fi les, 133 
PowerTa lk key chain, 70 

M 
Macintosh Guide 

Index, 94 
Topics, 93 

mail, see e-mail 
mailbox 

n am es, 81 
preferences, 77 

memory 
applications, 87 
RAM d isks, 60-61 

menu bar, 2 
menus, opening, 6 
monitors (color 

adjustments), 21 
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Index 

mounting network 
volumes, 98-100 

mouse (control settings), 
23-24 

moving 
icons, 5 
windows, 7 

N 
naming 

folders, 90-91 
icons, 4 
mailboxes, 81 

networks 
access privileges 

checking, 109 
denying, 106 
guest access, 

118-119 
restricting to sh ared 

items, 113-114 
setting, 107-108 

connecting, 98 
file Sharing Monitor, 

11 7 
passwords, 110-112 
sharing setup, 102-103 
terminating share 

privileges, 114-116 
users 

d isconnecting, 117 
registering, 104-105 

volumes 
moun ting, 98-100 
unmounting, 101 

New User command (File 
menu), 104 

Note Pad 
dele ting, 52 
fonts, 49-50 
printing, 51 
quitting, 52 

0 
opening 
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AppleTalk Catalog, 71 
applications, 83, 85, 88 
CD-ROM discs, 64 
documen ts, 83, 88 

p 

enclosures (e-mail), 
79-80 

icons, 4 
menus, 6 
PowerTalk key chain, 

65-67 

passwords, 110-112 
Paste command (Edit 

menu), 20 
pasting data, 34-35 
PC disk icon, 62 
PC Exchange, 43-45 
PODs (portable d igital 

documents) 
creat ing, 129-130 
pri nting, 131-132 
viewing, 131 

peer-to-peer mail, 65 
PowerTalk 

Access code prompt, 69 
key chain 

deleting, 68 
locking, 70 
opening, 65-67 
unlocking, 70 

turning mail on/off, 69 
preventing application 
switchout, 86 

printing, 124 
batch printing, 128 
deleting jobs from 

queue, 128 
holding print jobs, 127 
Note Pad, 51 
PO Ds, 131-132 
printer status, 125-126 
resuming print jobs, 

127 
status checks, 125 
switching printers, 

124-125 
window contents, 13-14 

program linking, 119-120 
pro tecting 

Applications folder, 134 
disks, 133 
files, 133 
System Folder, 134 



published documents, 40, 
42 

Put Away command 
(File menu), 64 

puzzle, see jigsaw Puzzle 

Q 
Quick Draw GX, 121 
quitting 

R 

e-mail, 76 
jigsaw Puzzle, 56 
Note Pad, 52 

RAM disks, 60-61 
reading Sticky notes, 33 
rebuilding the Desktop, 136 
recently used 

applications/documents, 
83 

recording sounds, 139 
recovering files from Trash 
Can,92 

registering network users, 
104-105 

removing 
Apple menu items, 22 
control panels, 32 
fonts, 122 
Launcher items, 89 
RAM disks, 61 
sounds, 138 

repairing disks, 134-136 
resizing windows, 8 
restricting access to shared 

items, 113-114 
resuming print jobs, 127 

s 
saving 

e-mail, 75, 79-80 
extensions, 30-31 
folder location s, 91 

Scrapbook 
appending, 36-3 7 
copying to documents, 

38-39 

Index 

security 
Applications folder, 134 
protecting files/disks, 

133 
System Folder, 134 

selecting icons, 3 
sending e-mail, 75-76 
setting user access 

(networks), 107-109 
Sharing command (File 

menu), 103 
sharing setup, 102-103 
showing 

Launcher, 90 
windows, 9 

shrinking windows, 14 
solving jigsaw Puzzle, 55 
sounds 

alert sounds, 137 
AppleCD Audio Player, 

140 
installing, 138 
recording, 139 
removing, 138 

startup disks, 58 
Sticky notes 

creating, 32 
reading, 33 

submenus (Apple menu), 23 
Subscribe To command 

(Edit menu), 41 
subscriber documents, 

41-42 
switching 

applications, 88 
printers, 124-125 

System extensions, see 
extensions 

System Folder, protecting, 
134 

T 
terminating share 

privileges, 114-116 
testing disks, 134-136 
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Index 

text 
copying, 34 
cutting, 35 
highlights (color), 16 
pasting, 35 

time, 25-28 
formatting, 25 

Trash Can, 2, 92 
turning on/off, 1 

u 
unlocking PowerTalk Key 

Chain, 70 
unmounti ng network 

volumes, 101 

v 
viewing 

icons, 12 
PDDs, 131 
windows, 9-11 

virtual memory, 59 
volumes 

mounting on the 
Desktop, 98-100 

unmounting on the 
Desktop, 101 

W-Z 
windows 

bringing to front, 8 
capturing, 13-14 
cleaning up, 11-12 
closing, 7 
colo r, 16 
hiding, 9 
moving, 7 
printing contents, 13-14 
resizing, 8 
showi ng, 9 
viewing, 9-11 

WindowShade, 14-15 
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4· 

- Data Exchange: Clipboard, Publish & subscribe, PC Exchange -

Using Publish and Subscribe 
Uslnj.: C.opy and l'.:.~tt', )'Ou cul lla~te a cha rt or logo IIIlo a u01hcr 
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